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Manufacturer’s responsibility

The manufacturer, installer, or importer will be responsible for the safety, reliability, and performance
of the equipment only if:
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+ Installation, modifications, adjustments, changes, or repairs are performed by suitably qualified
service personnel.

* The electrical installation of the site in which the equipment is used is according to an applicable
safety standard (UL, CSA, or IEC/CDE).

* The equipment is used according to the instructions provided in the operation manuals.

External software licenses

(Topic number: 7696)

Information about third-party software licenses and copyrights can be found in External
software licenses (refer to page 84).

Giving feedback on the documentation

(Topic number: 122201)

Thank you for taking the time to provide feedback. Your comments will be forwarded to the group
responsible for this product’s documentation.

To give feedback on the documentation

1. In an email subject line or body, list which product, version, and publication you are
commenting on.

For example, “IMPAX 6.4 SU01 Client Knowledge Base: Extended*. (You can find this
information in the footer of the publications.)

2. Describe the incorrect, unclear, or insufficient information. Or, if you found any sections
especially helpful, let us know.

3. Provide topic titles and topic numbers where applicable.
Including your personal contact details is optional.

4. Send the email to doc feedback@agfa.com.

Sorry, we cannot respond directly to every submission and we cannot accept requests for changes
in the product; instead, contact your product sales representative or the product’s technical support
channel.
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Getting started

Understanding certain key concepts and system requirements helps ensure a successful upgrade.

What is an IMPAX 6.5.1 standalone?

(Topic number: 7596)

In IMPAX 5.3 and earlier releases, a standalone station contained both Server and Client components,
which an installation package bundled together. Diagnostic-quality monitors were always supported.
The stations could run under Windows 2000 or Windows XP.

With IMPAX 6.0 and later, the IMPAX AS300 Server, Application Server, and Client software were
all installed on the same computer—but these installation packages were not bundled together.
These standalone stations ran under Windows XP.

As of IMPAX 6.5, all new standalone stations were installed under Windows 7 as the host operating
system. Using VMware Player, the AS300 Server and Application Server components were installed
under Windows Server 2008 as the guest operating system.

Upgrades of existing standalone stations
Existing IMPAX standalone stations can be upgraded to IMPAX 6.5.1:

+ If they are on IMPAX 6.5 and running on Windows 7 (host operating system) and Windows
Server 2008 (guest operating system) using VMware Player.

or
« if they are currently running on Windows XP and if they meet the minimum hardware

requirements (refer to page 9). If running SQL Server 2000, an upgrade to SQL Server 2008
is required. (If running SQL Server 2005, this version can be retained.)
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Primary purpose

The primary purpose of a standalone is to provide a workstation that can operate independently of
a full IMPAX cluster and can communicate (send and receive studies) with other devices via DICOM.

Situations in which standalone stations may be used include:

* Quality control workstation that sits between a modality and the main PACS cluster.

+ Regular workstations in which the functionality of the new release is required prior to the main
PACS cluster being upgraded. In this case, studies are typically routed to the standalone
workstation from the main IMPAX cluster and reviewed there.

* Regular workstations at a small site where IMPAX is being introduced.

The IMPAX 6.5 standalone station does not support the following:

+ Direct attached archives
+ PACS Store and Remember archiving or HSM archiving
+ External disk options or DAS

+ Connectivity Manager and RIS integration

Recommended boundaries for optimal performance

The following are the recommended boundaries inside which a standalone station should be deployed
and serviced.

E Note:

Exceeding one of the boundaries may reduce performance and indicate the need for a
single-server configuration instead of a standalone station; a combination of these
factors—even when below the maximum value—may also indicate this need. (For more about
the single-server configuration, refer to “Installing an IMPAX AS300 single-server” (topic
number 67064) in the IMPAX 6.5.1 AS300 Installation and Configuration Guide.)

+ Maximum of three modalities

+ Maximum of 15,000 exams/year

+ Maximum of 0.5 million images/year

+ Maximum yearly volume of 0.6 TB uncompressed

+ Maximum of one concurrent user: Radiologist or Radiologist with QC license
+ Maximum exam volume of 1.5 GB/day

Maximum peak volumes should not exceed the following:

+ Exam volume peak per hour (raw data, for CR) < 1 GB/hour

+ Exam image peak rate per hour (for CT) < 3000 images/hour
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+ Maximum of one single user

System requirements for upgrading standalone
stations

(Topic number: 114785)

Existing IMPAX standalone stations can be upgraded to IMPAX 6.5.1:

« If they are on IMPAX 6.5 and running on Windows 7 (host operating system) and Windows
Server 2008 (guest operating system) using VMware Player.

or

« If they are currently running on Windows XP and if they meet the minimum hardware
requirements. If running SQL Server 2000, an upgrade to SQL Server 2008 is required. (If
running SQL Server 2005, this version can be retained.)

Stations that do not meet the minimum hardware requirements or that require an operating system
upgrade cannot be upgraded. Instead, a new standalone installation must be performed, following
the procedures in the IMPAX 6.5.1 Standalone Installation and Configuration Guide.

Component Minimum hardware requirement for standalone upgrade
Workstation HP xs56600 or equivalent

RAM 4GB

CPU 1 x Dual-Core (Intel XEON 52xx)

Video For enhanced CT/MR navigation, minimum BARCO MXRT-5200

IMPAX standalone: Additional documentation

(Topic number: 7599)

The IMPAX 6.5.1 Standalone Installation and Configuration Guide is intended for service and
administrator personnel who are installing and performing the initial configuration of an IMPAX
standalone station. It provides information about the required components and instructions for the
installation.

The IMPAX 6.5.1 Standalone Upgrade Guide is intended for service and administrator personnel
who are upgrading an IMPAX standalone station. It provides information about the required
components and instructions for the upgrade.

Some procedures refer you to other IMPAX guides for details; notably, these ones:
+ IMPAX 6.5.1 Preparing to Upgrade Guide—IMPAX 4.5, 5.2, 5.3, or WEB1000 to IMPAX 6.5.1

* IMPAX 6.5.1 Preparing to Upgrade Guide—IMPAX 6.2 or later to IMPAX 6.5.1
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« IMPAX 6.5.1 Application Server Installation, Upgrade, and Configuration Guide
+ IMPAX 6.5.1 Client Installation, Upgrade, and Configuration Guide

Details concerning customization and use of the IMPAX standalone software are provided in the
IMPAX 6.5.1 Client Knowledge Base: Extended, IMPAX 6.5.1 Application Server Knowledge Base, and
IMPAX 6.5.1 Server Knowledge Base.

All Knowledge Bases and all guides are available on the IMPAX Documentation DVD. This
documentation also gets installed on the standalone station, as described in Installing the IMPAX
documentation (refer to page 62).

Valid IMPAX upgrade paths

(Topic number: 6607)

Sites can upgrade to IMPAX 6.5.1 from any of these versions of IMPAX (supported versions include
any applicable SUs):

« IMPAX 5.2.5—hereafter referred to as IMPAX 5.2

« IMPAX 5.3.1, 5.3.2—hereafter referred to as IMPAX 5.3

IMPAX 6.2.1—hereafter referred to as IMPAX 6.2

« IMPAX 6.3.1—hereafter referred to as IMPAX 6.3

IMPAX 6.4
+ IMPAX 6.5

For more detailed information, refer to the IMPAX 5.x - 6.x Service Update and Hot Fix Migration
Paths spreadsheet in the “Additional documents” section of the IMPAX Knowledge Base > Main
Knowledge Base Page.

Important!

We recommend checking the migration log file after each leg of an upgrade before moving
onto the next leg.

Additional information:
+ For IMPAX AS300 upgrades, SQL Server 2008 is supported.

+ To upgrade an IMPAX AS300 cluster from SQL Server to Oracle, contact Agfa Professional
Services for assistance. The SQL Server to Oracle migration process is not documented in this
guide.

* The Application Server platform is either Windows Server 2003 or Windows Server 2008.
Windows 2008 is supported for fresh installations only; unless already on Windows 2008,
Windows 2003 must continue to be used for upgrades. All Application Servers in a cluster must
use the same operating system—either Windows 2003 or Windows 2008.
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Preparing to upgrade a
standalone

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

Only upgrades of existing standalone stations are supported. If the standalone server hardware does
not meet the minimum hardware requirements (refer to page 9), or if an operating system upgrade
is required, you cannot upgrade. Instead, perform a new standalone installation on a new server,
following the procedures in the IMPAX 6.5.1 Standalone Installation and Configuration Guide.

If the standalone is already on IMPAX 6.5 and running on Windows 7 (host operating system) and
Windows Server 2008 (guest operating system) using VMware Player, or if the standalone is running
Windows XP and meets the minimum hardware requirements, you can prepare it for upgrade to
IMPAX 6.5.1.

1. Obtaining Server license keys

(Topic number: 7637)

IMPAX uses software license keys that are unique to the station on which the software is installed.
On a standalone station, a license key is required for the Network Gateway component. If upgrading
from IMPAX 5.2, 5.3, 6.2, or 6.3, you must obtain a new license. If upgrading from IMPAX 6.4 or
later, you can continue to use the same license.

Standalone Upgrade Guide—IMPAX 6.5.1 11
Agfa Company Confidential—Subject to Non-Disclosure Obligation



Obtaining Server licenses for Windows stations
(Topic number: 10699)

To obtain new license keys, if this is required, email licensekey@agfa.com. To generate the license
keys, Agfa must know the Ethernet MAC (Media Access Control) address of the server.

To obtain Server licenses for Windows stations
1. For each Windows server, open a command prompt and type ipconfig /all.

The MAC address of all Ethernet cards installed on the station are listed. You can use any of
these to generate the license from.

2. Copy one of the returned MAC addresses to a secure place.

Ensure that you copy down the address exactly as it appears, including leading zeroes.

E Note:

The MAC addresses contain only the alphanumeric characters 0-9 and A-F.

3. To obtain a license key for the server, send the MAC address information to
licensekey@agfa.com, along with the type of component being installed on that server.

2. Installing the IMPAX 6.5.1 Migration Toolbox

(Topic number: 9911)

The tools in the IMPAX 6.5.1 Migration Toolbox automate some of the migration and upgrade
tasks. The tools are run from a command prompt and do the following:

+ Extract relevant information from the database.
+ Transform the database schema and data.

+ Coordinate the execution of tools across multiple machines.

Installing the Migration Toolbox on a Windows station
(Topic number: 11493)

To install the Migration Toolbox, you must be logged into Windows as an administrator-level user.

The migration tools are on a dedicated Migration CD.

To install the Migration Toolbox on a Windows station
1. Insert the IMPAX Migration CD.

2. Navigate to the win32 directory and double-click impax_65_migration-winpkg-6.5.1.xxx.exe
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where xxx is the build number.

3. In the InstallShield Self-extracting EXE dialog, click Yes.
Setup progress dialogs appear.

4. On the Welcome screen, click Next.

5. If prompted, select the type of database server and then click Next. (When upgrading from
IMPAX 6.2 or IMPAX 6.3, skip this step.)

6. On the Select Features screen, select the checkboxes of the features that you want to install,
and clear the rest.

When upgrading a standalone station, select all the features except the Oracle on Windows
Migration Tools.

7. Click Next.
8. To continue, click Install.

9. If you selected the Worklist and Report Migration Tools on the Select Features screen, when
prompted, press any key to continue.

10. On the Setup Complete screen, click Finish.

The Migration Tools are installed in the C:\mvf-mig6\bin directory, with the following exceptions
for SQL Server databases:

Executable Installed in

migrate-users C:\mvf-mig6\UserMigration

Training/Traveling Server (MigrateTRServer.exe) C:\mvf-mig6\MigrateTRServer

3. Creating the pre-migration schema on an AS300
server

(Topic number: 59199)

These steps assume that the Migration Tools have been installed on the server and that you are
running the commands on the server itself. You must also be logged into Windows as an
administrator-level user.

To create the pre-migration schema on an AS300 server
1. Open a command prompt.

2. If upgrading from IMPAX 6.2 or later, retrieve the sa password as follows:
a. Change to the C:\mvf\bin directory.
b. Type
passkey -M QUERY -u sa

The sa password is returned.
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3. Change to the C: \mvf-mig6\bin directory.
4. If upgrading from IMPAX 5.2 or 5.3, type
build-impax-mig-schema.bat sa sa mvf

5. If upgrading from IMPAX 6.2 or later, use the sa password retrieved in step 2 in the following
command:

build-impax-mig-schema.bat sa sa_password mvf

The pre-migration database schema and data are created.

4. Taking a system snapshot

(Topic number: 7613)

Before migrating to IMPAX 6.5.1, use the migration_inventory tool to capture the current state of
the system for later comparison.

To take a system snapshot
1. Ata command prompt, change to the C:\mvf-mig6\bin directory.

2. Type

migration_inventory -d database_name -U database_user_name -P database_password -s
-D standalone_station_host_name

The output is stored in the migration_info table. It lists the number of IMPAX studies, total
objects, and objects in cache. It also lists all IMPAX source stations and DICOM printers.

3. To create a report file with this information, type
mig reporter -t system_inventory_tool

This command writes the output of the migration_inventory command to a report file in the
C:\mvf-mig6\reports directory. For other parameters you can use with the mig_reporter.exe
command, refer to “mig_reporter.exe” (topic number 10619) in the appropriate version of the
IMPAX Preparing to Upgrade Guide.

5.Stop transmitting data to IMPAX

(Topic number: 7617)

Allow remaining SEND jobs to continue until they have finished, then stop any more studies from
being transmitted in the IMPAX system.

To stop transmitting data to IMPAX
1. Open the Windows Administrative Tools and select Services.

2. Right-click the DICOM Service Class Provider service and select Properties.
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To change the Service status, click Stop.
From the Startup type list, select Disabled.
To close the Properties dialog, click OK.

AL

Launch the 5.2 or 5.3 Service Tools or the 6.2 or later Administration Tools and log in as user
service.

7. On the Daily tab, select Job Manager. 0

8. Monitor each Transmit queue and wait for all outgoing jobs to finish.
You cannot delete jobs in progress.

9. Select each Transmit queue and click Halt Queue. @

10. To confirm that you want to halt the queue, click Yes.

6. Emptying all queues

(Topic number: 7702)

Monitor the Job Manager to make sure that all the queues are empty and that all jobs are completed
prior to the upgrade.

To empty all queues
1. In the 6.2 or later Administration Tools, on the Daily tab, select Job Manager.
In the 5.2 or 5.3 Service Tools or the 6.2 or later Administration Tools, on the Daily tab, select
Job Manager. [

2. Ifan archive job remains in any of the queues, select the job and click Expedite Selected Job(s).

g

3. If any other job remains in any of the queues, select the job and click Delete selected job(s).

-

W

7.Deleting cache locations for studies

(Topic number: 7707)

Important!
This topic applies only when upgrading an existing IMPAX 5.2 or 5.3 server to 6.5.1.

If you are not restoring the files in the cache directory after the upgrade, to prevent database
inconsistencies, remove all database references to images in cache.

To remove references to images in cache, find all study_refs that are in the cache and delete them.
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To delete cache locations for studies

1. On a station with a cache containing database references to remove, log in as mvf user and
launch CLUI and type the following:

cache query
A list of caches and their volume_refs is displayed.
2. To store all study_refs into variable g, type

save_refs a select distinct ds.study_ref from dosr_study ds, dosr_object do where ds.study_ref
= do.study_ref and do.object_ref in (select object_ref from osr_location where volume_ref
= volume_ref)

where volume_ref is the volume reference of the cache.
3. To enter menu mode, type
Go menu
Select Study Manager.
Select Delete Studies Menu.
Select Delete Study from Cache.

Ny

To process the study_refs stored in the variable a, at the command prompt, type a.

All studies in the volume_ref’s cache are removed.

8. Stopping antivirus software

(Topic number: 7616)

If you have antivirus software installed on any Windows-based servers, ensure that no scan jobs are
running that would interfere with the upgrade process. Stop the antivirus services.

To stop antivirus software
1. On a Windows server to upgrade, launch the antivirus software.

2. Halt the scan operation according to the vendor’s instructions.

9. Deleting old log files

(Topic number: 7706)

On the server being upgraded, remove any old log files to ensure that all future log information is
a result of the upgrade procedure.

To delete old log files
1. On the server to be upgraded, open a command prompt.

2. Change to the C:\mvf\bin\ directory.
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3. Run stopall.bat.
4. For future reference, copy all files in C:\mvf\data\logs\ to a backup location.

5. Delete all the log files from C:\mvf\data\logs.

10. Uninstalling IMPAX documentation

(Topic number: 7610)

You must uninstall any existing IMPAX documentation before you can install the new IMPAX 6.5.1
documentation.

Uninstalling IMPAX 5.2 or 5.3 documentation

(Topic number: 10734)

IMPAX 5.2 and 5.3 had separate Client and Server Knowledge Bases, each of which must be separately
uninstalled.

Removing the IMPAX 5.2 or 5.3 Client Knowledge Base
(Topic number: 58578)

If the IMPAX 5.2 or 5.3 Client Knowledge Base is installed, you must uninstall it before upgrading.

To remove the IMPAX 5.2 or 5.3 Client Knowledge Base
1. Open Control Panel.
2. Select Add or Remove Programs.

3. Select IMPAX Client Knowledge Base 5.2 or IMPAX Client Knowledge Base 5.3 and click
Change/Remove.

4. In the Confirmation dialog, click OK.

5. If also uninstalling the IMPAX Server Knowledge Base, in the Maintenance Complete dialog,
select No, I will restart my computer later. Otherwise, select Yes, I want to restart my computer
now and click Finish.

6. If you restarted the computer, log into Windows as an administrator-level user.

7. To remove any translations of the IMPAX 5.2 or 5.3 Client Knowledge Base, delete the
C:/impax/documents/client/translations directory.

Removing the IMPAX 5.2 Server Knowledge Base
(Topic number: 58581)

The IMPAX 5.2 Server Knowledge was used for both IMPAX 5.2 and 5.3 releases. If it is installed,
uninstall it before upgrading.
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To remove the IMPAX 5.2 Server Knowledge Base
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Select IMPAX Server Knowledge Base 5.2.

4. Click Change/Remove.

5. In the Confirmation dialog, click OK.

6. In the Maintenance Complete dialog, select Yes, I want to restart my computer now and click

Finish.

Once the computer restarts, log into Windows as an administrator-level user.

Uninstalling IMPAX 6.2 documentation

(Topic number: 10736)

You must uninstall the IMPAX 6.2 documentation before you can install the new IMPAX 6.5.1
documentation. Although the three IMPAX 6.2 Knowledge Bases are installed together, they must
be separately uninstalled.

To uninstall the IMPAX 6.2 documentation
Open Control Panel.

Select Add or Remove Programs.

Under Currently installed programs, select IMPAX 6.2 Documentation.

Click Change/Remove.

In the Confirmation dialog, click OK.

In the Maintenance Complete dialog, click Finish.

Under Currently installed programs, select IMPAX Application Server Knowledge Base.
Click Change/Remove.

Y ® N Uk D=

In the Confirmation dialog, click OK.

—_
o

. In the Maintenance Complete dialog, click Finish.

[a—
[a—

. Under Currently installed programs, select Impax Client Knowledge Base.

—_
[\

. Click Change/Remove.

—_
W

. In the Confirmation dialog, click OK.

—_
N

. In the Maintenance Complete dialog, click Finish.

—_
[9)]

. Under Currently installed programs, select IMPAX Server Knowledge Base.

—_
(o)

. Click Change/Remove.

—
N

. In the Confirmation dialog, click OK.

—_
o]

. In the Maintenance Complete dialog, click Finish.
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Uninstalling IMPAX 6.3 or later documentation
(Topic number: 15533)

You must uninstall the IMPAX 6.3 or later documentation before you can install the new IMPAX 6.5.1
documentation.

To uninstall IMPAX 6.3 or later documentation

1.
2.
3.

6.

Open Control Panel.
In Windows XP, select Add or Remove Programs.

In the Programs and Features dialog, under Currently installed programs, select AGFA IMPAX
version Knowledge Base buildnumber Documentation.

Click Remove.
In the confirmation dialog, click OK.

A progress dialog appears as the documentation is uninstalled, giving the amount of time
remaining. When the process is complete, the dialog closes.

Close the Programs and Features dialog.

All installed IMPAX documentation for the version selected is uninstalled.
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Installing IMPAX
Business Services and
migrating user data

When upgrading a standalone from IMPAX 5.2 or 5.3, you must do a new install of the IMPAX
Business Services and related software on the Windows XP station.

If upgrading a standalone from IMPAX 6.2 or later, skip ahead to the tasks in Upgrading IMPAX Server
software (refer to page 36).

1. Installing the IMPAX documentation

(Topic number: 15523)

Before installing the IMPAX 6.5.1 documentation, ensure that you have uninstalled any earlier
IMPAX documentation (refer to page 17).

IMPAX is shipped with three sets of documentation: the IMPAX 6.5.1 Client Knowledge Base:
Extended and related guides, the IMPAX 6.5.1 Application Server Knowledge Base and related guides,
and the IMPAX 6.5.1 Server Knowledge Base and related guides. The IMPAX documentation set
appears on its own installation DVD.

To install the IMPAX documentation
1. Insert the IMPAX Documentation DVD.

2. From the DVD root, double-click IMPAXDocumentationSetup.exe.
A Preparing to install message appears.
3. On the Welcome screen, click Next.
4. On the Setup Type screen, select the appropriate option and click Next.

+ To install all documentation in all available languages (up to 24 languages), select All
Documentation.
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+ To install all English-language documentation, select All English Documentation. This
is the default.

+ To select which documentation to install in which languages, select Select Documentation
to Install.

5. If you selected Select Documentation to Install, on the Choose Features screen, you can select
particular Knowledge Bases or languages to install.

+ To install the IMPAX Client Knowledge Base in two or more languages, click & -] beside
the name of the language to install and select This feature will be installed on the local
hard drive. (Note that English must be installed.)

+ To not install the IMPAX Server, IMPAX Application Server, or IMPAX Client
documentation, click i=~] beside the appropriate label and select This feature will not
be available.

6. On the Ready to Install the Program screen, click Install.
Installation progress messages are displayed.

7. On the InstallShield Wizard Completed screen, click Finish.

The selected IMPAX documentation is now installed. Shortcuts appear in the Start menu and on
the desktop. For additional details on viewing the translated documentation on the IMPAX Client
see Viewing translated documentation from the IMPAX Client Help menu

2. Installing the IMPAX Business Services

(Topic number: 9873)
The IMPAX Business Services must be installed.

To install the IMPAX Business Services
1. Insert the IMPAX Business Services CD.

2. Navigate to the appserver folder, which contains the Business Services software.
3. Run AGFA IMPAX Business Services Setup.exe.
4. Select the required software packages to install.

The following packages must be installed prior to the Business Services installation.

* Visual JSharp .NET 2.0
« .NET Framework 3.5 SP1
* Visual C++ 9.0 SP1 ATL Update (x86)

If any of these packages are listed in the InstallShield Wizard dialog, select them. If any of these
packages do not appear in the list, those packages are already installed.
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10.
11.
12.
13.

14.

15.

Installshield Wizard

O AGFA IMPAX Business Services 6.5.0.1361 requires the following items ta be installed on
L="1 your computer. Click Install to beqgin instaling these requirements.

Statuz | Requirement |
Pending “izual JSharp NET Rediztributable Package 2.0
Fending “izual C++ 3.0 5P1 ATL Update [«8E)

Install Cancel

. Click Install.

On the Welcome screen, click Next.

At the license agreement, select the I accept the terms in the license agreement checkbox.
Click Next.

On the Web Services Installation Folder screen, click Change.

. Select E:\\wwwroot as the location for the Web Services. Click OK.

Changing the location of the Web Services installs all of the web services to the same directory.
Click Next.

On the Setup Type screen, click Custom. Click Next.

On the RIS screen, click Next.

Click Install.

The IMPAX Business Services are installed.

When complete, optionally select the Show the readme file and Launch IMPAX Business
Services Configuration tool checkboxes.

Click Finish.

The IMPAX Business Services are installed. If selected, the Configuration Tools are displayed.

3.

Configuring IS error messages on Windows XP

(Topic number: 118706)

Configure IIS to display the correct error message if the Knowledge Base cannot be found.
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To configure IS error messages on Windows XP

1. Open the Windows Administrative Tools and select Internet Information Services (IIS)
Manager.

Expand computer_name > Web Sites > Default Web Site.

Right-click the Documents file and select Properties.

Switch to the Custom Errors tab.

In the list of Error messages for HT'TP errors, select 404.

Click Edit.

Under Message Type, select URL.

In the URL field, type /AgfaHC.LanguageRedirect/LanguageRedirect.aspx.

¥ ® N Uk w D

To close the two dialogs, click OK in each.

—_
o

. To close the Internet Information Services (IIS) Manager window, select File > Exit.

4. Verifying the Business Services installation

(Topic number: 7598)

You can verify the IMPAX Business Services installation by checking whether IIS works.

To verify the Business Services installation
1. Open a web browser and connect to http://localhost.

2. Verify that the “IMPAX Documentation” page is displayed.
or

If the IMPAX Documentation has not been installed on the server, that the “Welcome to
IMPAX 6.5.1” page is displayed.

5. Establishing an SSL connection

(Topic number: 11279)

Use the Security Wizard to generate a certificate request to submit to a trusted certificate authority,
import an SSL certificate, and assign it to services.

Creating an SSL certificate request
(Topic number: 7709)

Generate a certificate request that can be submitted to a trusted certificate authority (refer to page
25). The information required by the wizard to create the certificate request is prefilled from the
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network settings of the server. If you already have the SSL certificate from the certificate authority,
skip this topic and go to Importing an SSL certificate in the Security Wizard (refer to page 26).

To create an SSL certificate request

1.

10.

11.

12.

To open the Security Wizard, select Programs > Agfa HealthCare > Business Services >
Security Wizard.

On the Select a method screen, select Work with SSL certificates. Click Next.

. On the Agfa Certificate screen, select Create a new certificate request. Click Next.

On the Organizational information screen, type the name of your Organization and
Organizational Unit. Click Next.

. On the Your site’s common name screen, type the fully qualified domain name of the machine

or load balancer, as appropriate, if it is not present by default. Click Next.

The fully qualified domain name consists of a host, domain name, and top-level domain. For
example, machinename.networkname.hospitalname.com. You should be able to ping the fully
qualified domain name.

On the Geographical Information screen, type the Country/Region, State/Province, and
City/Locality information for your site. Click Next.

You must type a two-letter code (ISO standard) in the Country/Region and State/Province
fields, or the SSL certificate request will fail.

Example:
For Country/Region: United States, type US.
For Province/State: North Carolina, type NC.

On the Certificate Key Length screen, select the length of the certificate key from the list. Click
Next.

On the Certificate Request File Name screen, in the File Name field, browse for or type a location
and name for the request file.

The default file name and location is C:\certreq.txt. To avoid overwriting certificate request
files, ensure that each request file has a unique name.

To copy the information in the certificate file to the Clipboard, select the Copy certificate file
contents to clipboard on creation checkbox.

By selecting this option, the information in the certificate request is copied to the Clipboard
so that you can paste it into the certificate authority’s online application form.

If your system uses a load balancer, select the Allow certificate to be installed on multiple
machines (exportable) checkbox. Click Next.

On the Request File Summary screen, click Finish.
The certificate request is created and saved as a .txt file.

In the Certificate Enrollment dialog, click OK.
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Submitting a certificate request to a certificate authority
(Topic number: 11411)

You cannot use the Application Server component without an SSL certificate. Purchase a 128-bit
encrypted SSL certificate from a trusted Certificate Authority to guarantee security.

To submit a certificate request to a certificate authority
1. Create an SSL certificate request (refer to page 23).

2. Open a web browser and go to the website of a certificate authority.

For a list of trusted certificate authorities, consult Viewing the list of certificate authorities in
Internet Explorer (refer to page 25).

3. Purchase a 128-bit encrypted SSL certificate by following the instructions on the certificate
authority’s website.

The exact steps may vary, depending on which trusted certificate authority is used.

After you have received the SSL certificate from the certificate authority, import and assign it.

Viewing the list of certificate authorities in Internet Explorer
(Topic number: 50237)

Use a trusted certificate authority when requesting an SSL certificate.

To view the list of certificate authorities in Internet Explorer
Open Internet Explorer.

Select Tools > Internet Options.
Switch to the Content tab.
Under Certificates, click Certificates.

A A

Switch to the Trusted Root Certification Authorities tab.

The list of certificate authorities recognized by Internet Explorer is displayed.

Tip:

Trusted certificate authorities include Verisign http://www.verisign.com, Thawte
http://www.thawte.com, Entrust http://www.entrust.com, Comodo http://www.comodogroup.com,
and Globalsign http://www.globalsign.com. These certificate authorities are already trusted
by Internet Explorer.

If using your own certificate authority, on each Client, ensure that Internet Explorer is configured
as follows: the Check for publisher's certificate revocation option is selected and the
Check for server certificate revocation option is cleared.
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Importing an SSL certificate in the Security Wizard
(Topic number: 11422)

Once you have received an SSL certificate from the certificate authority, you must import it through
the Security Wizard before assigning it. When installing an SSL certificate, assign it to all available
services.

To import an SSL certificate in the Security Wizard
. Open the Security Wizard.

1

2. On the Select a method screen, select Work with SSL certificates. Click Next.

3. On the Agfa Certificate screen, select Import a certificate from file. Click Next.

4. On the Certificate Import information screen, click Browse and navigate to the certificate file.
Certificate files have a .cer extension.

5. Click Finish.

The certificate is now imported and must be assigned to services.

Assigning an SSL certificate in the Security Wizard
(Topic number: 50234)

Once you have received and imported an SSL certificate from the certificate authority, assign it to
all available services.

To assign an SSL certificate in the Security Wizard
1. Open the Security Wizard.

2. On the Select a method screen, select Work with SSL certificates. Click Next.

3. On the Agfa Certificate screen, select Assign an existing certificate to services. Click Next.

4. On the Available Certificates screen, verify that the imported certificate is selected. Click Next.
5

. On the Available Services screen, select all services listed, including Internet Information
Systems and ADAM/AD LDS: Agfa Healthcare. Click Finish.

6. Atthe Successfully applied certificate to services prompt, click OK.

The certificate is now installed and will be used by all selected services.

6. Creating the administration account

(Topic number: 7708)

The administration account must be created for logging into the IMPAX Client and configuring
additional users.
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Note:

The administration account is available only after an SSL certificate has been installed on the
standalone station.

To create the administration account

1.
2.

Open the Security Wizard.

On the Agfa Security Wizard screen, select Work with the Application Server default settings.
Click Next.

. On the Web Services URL Configuration screen, click Next.

If you are using a production license, set up an administrator user.
a. On the User Management screen, select Add Administrator.
b. Type the user name and password
c. To confirm the password, type it a second time.
d. Click Next.

Click Add Administration License.

. Browse to the location of the license.

The default location for licenses is C:\Program Files\Agfa\Impax Business Services\Licensing
Admin Tool. The site received an administrator license with the IMPAX 6.5.1 installation
package.

. Select the administration license and click Open.
. Click Finish.
. At the prompt, click OK.

The administration license is installed and activated.

The administration account has been created and the administrator user can log into the
IMPAX Client (once it is installed).

7.Connecting to the ADAM server

(Topic number: 121258)

The ADAM database maintains all the security around user profiles, access controls, and station
information on the Windows XP standalone station. Connect to the ADAM server so that IMPAX
Client users can be added.

To connect to the ADAM server

1.
2.

Open the Business Services Configuration Tool.

Switch to the Security tab.
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3.

5.

In the Server Fully Qualified Hostname field, type the domain and host name of the ADAM
server, if it is not already populated.

The fully qualified domain name consists of a host, domain name, and top-level domain. For
example, machinename.networkname.hospitalname.com.

On a standalone station, the primary instance of ADAM is on the server you are configuring,
and the fully qualified domain name and port number are automatically populated from the
DSN information on the computer.

If necessary, type the Port number of the ADAM server.
The default port number of the ADAM server is 636.
Click Apply.

8. Connecting the Business Services to the SQL

Server database

(Topic number: 7713)

Configure the Business Services to communicate with the SQL Server database that contains all the
patient information.

To connect the Business Services to the SQL Server database

1.

Open the IMPAX Business Services Configuration Tool.

2. Switch to the Database tab.
3. Under PACS Database Settings, select SQL Server.
4. In the SQL Server Name field, type the name of this standalone station.
5. Click Configure ODBC.
6. In the ODBC Data Source Administrator dialog, switch to the System DSN tab.
7. Click Add.
8. In the Create New Data Source dialog, select SQL Server. Click Finish.
9. In the Create a New Data Source to SQL Server dialog, as the Name, type mvf_sql.
10. As the Description, type mvf.
11. From the Server list, select the name of this standalone station. Click Next.
12. Click SQL Server Authentication.
13. Ensure that the Connect to SQL Server to obtain checkbox is selected.
14. As the Login ID, type mvf.
15. As the Password, type mvf.
16. Click Client Configuration.
17. In the Add Network Library Configuration dialog, ensure that TCP/IP is selected. Click OK.
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18.
19.
20.
21.
22.
23.
24,
25.
26.
27.

Click Next.

Select the Change the default database to checkbox.

From the list, ensure that mvf is selected. Click Next.

Clear the Perform translation for character data checkbox. Click Finish.

To test the connection, click Test Data Source.

When prompted that the connection was successful, click OK.

To close the ODBC Microsoft SQL Server Setup dialog, click OK.

To close the ODBC Data Source Administrator dialog, click OK.

In the IMPAX Business Services Configuration tool, click Test.

If the message Connection to SQL Server database successful appears, click OK.

If the test fails, verify that the SQL Server Name is correct and test the connection again.

9. Armoring the Application Server

(Topic number: 7741)

After completing the previous Application Server configuration steps, you must apply them. When
you apply these settings, the security settings for the Application Server are also applied.

To armor the Application Server

1.
2.

On any tab of the IMPAX Business Services Configuration tool, click Apply.

If a Please enter an IP Address for Connectivity Manger [sic] IP Filtering message appears, click
OK.

. Switch to the Web Services tab.

Under the Connectivity Manager IP Filtering section, in the Grant Access to IP textbox, type
127.0.0.1 as the IP address.

. Click Add.

After the IP has been added, to apply the change, click Apply.

All configuration changes and the armoring settings are applied to the Application Server
components. This process may take a few minutes to complete.

If prompted for an Enterprise URL Hostname, type the fully qualified host name of this
standalone station.

. Click OK.

In the Agfa Configuration Results dialog, click OK.
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Important!

When configuring the Application Server on Windows 2003 SP2, including IMPAX RIS,
the Configuration Results screen and the log file (c:\impax\logs\configurator.log) display
an Oracle error that should be ignored. Example: ERROR UpdateDatabase(): Unable
to save report source configuration to the database. Any changes made
to report sources will be lost. This error does not display on Windows 2008 SP2
server.

10. Exporting user data

(Topic number: 9920)

Follow this procedure to export all IMPAX 5.2 or 5.3 user information. The exported data includes
access controls, privileges, preferences, and station configurations.

The XML file created by this procedure can be used for reference, and some of the user data is later
imported into the IMPAX 6.5.1 ADAM database.

B caution

If you need to run the migrate-users.exe -m mvf2xml command a second time on the same
database, you must delete all entries from the LDAP_user_mapping table in the database
before proceeding.

To export user data
1. Open a command prompt.

2. Change to the C:\mvf-mig6\UserMigration directory.
3. To export IMPAX 5.2 or 5.3 user information, type

migrate-users.exe -m mvf2xml -d mvf_version_number-U IMPAX_5.2_or_5.3_database_user
-P IMPAX_5.2_or_5.3_database_password

Depending on the number of users being exported, this step can take up to 20 minutes to complete.

The users.xml file is created on the server, listing all users and their preferences and station
configurations. Wizards and other information that will not be migrated to IMPAX 6.5.1 are also
exported to this XML file for reference.

Once an IMPAX 6.5.1 Client software has been installed and configured on this station, using the
text file created from the exported IMPAX 5.2 or 5.3 Select wizards, create the appropriate IMPAX
6.5.1 standard worklists. For additional information on standard worklists, refer to “Managing
studies using worklists” (topic number 8430) in the IMPAX 6.5.1 Client Knowledge Base: Extended.

Other parameters supported by this tool are listed in “migrate-users.exe” (topic number 10621) in
the IMPAX 6.5.1 Preparing to Upgrade Guide—IMPAX 4.5, 5.2, 5.3, or WEB1000 to IMPAX 6.5.1.

Standalone Upgrade Guide—IMPAX 6.5.1 30
Agfa Company Confidential—Subject to Non-Disclosure Obligation



Deleting special characters in user names
(Topic number: 60402)

IMPAX 6.5.1 is more restrictive on what constitutes a valid user name than IMPAX 5.3 and earlier
were. To avoid problems in exporting user profiles into ADAM, delete invalid characters from the
exported user names in advance.

To delete special characters in user names
1. Open the users.xml file in a text editor.

2. In each UserName and Fullname field, check for and delete any instances of the following
characters:

=+<>#;/\

3. Save and close the users.xml file.

11. Recording and disabling the password and
account lockout policies

(Topic number: 6707)

The password and account lockout policies required by the site are determined by the hospital’s IT
department. During the preparing to upgrade phase, these policies must be disabled so that user
data can successfully be migrated to IMPAX 6.5.1. IMPAX 4.5, 5.2, or 5.3 passwords are unlikely to
conform to the new IMPAX 6.5.1 password standards, so they would fail if the policies were left in
place.

For a description of each password and account lockout policy, refer to “Password and account
lockout policies: Reference” (topic number 11366) in the IMPAX 6.5.1 Application Server Knowledge
Base.

Before disabling the settings, record the password and account lockout policy settings.

Password policy settings
(Topic number: 6646)

Password policy Setting

Enforce password history
Maximum password age

Minimum password age

Minimum password length
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Password policy Setting

Password must meet complexity requirements

Store password using reversible encryption for all users in the
domain

Account lockout policy settings
(Topic number: 58212)

Account lockout policy Setting

Account lockout duration
Account lockout threshold

Reset account lockout counter after

Disabling the password and account lockout policies
(Topic number: 6734)

B caution

To change the password policy settings for a standalone station on the domain, the station
must first be taken off the domain, added to the Workgroup, then restarted.

Once the original password and account lockout policies are recorded, you can disable them.

To disable the password and account lockout policies
1. Open the Windows Administrative Tools and select Local Security Settings.

2. In the navigation pane, expand Account Policies and select Password Policy.
3. To modify the Password Policy information, double-click the policy to be changed.

Change each password policy to have the following settings:

Password policy Setting

Enforce password history 0
Maximum password age 0
Minimum password age 0
Minimum password length 0
Password must meet complexity requirements Disabled
Standalone Upgrade Guide—IMPAX 6.5.1 32

Agfa Company Confidential—Subject to Non-Disclosure Obligation



Password policy Setting

Store password using reversible encryption for all users Disabled
in the domain

4. Under Account Policies, click Account Lockout Policy.
5. To modify the Account Lockout Policy information, double-click Account lockout threshold.
6. Set its value to 0 and click OK.
This automatically changes the other values to Not Applicable.
7. To close Local Security Settings, select File > Exit.

12. Backing up the ADAM database

(Topic number: 6717)

The ADAM database maintains all the security around user profiles, access controls, and station
information on the Windows XP standalone station. Backing up the ADAM database at this time is
important prior to an Application Server upgrade or in advance of migrating user data into it.

To back up the ADAM database
. Select Start > All Programs > Accessories > System Tools > Backup.

1
2. Select Tools > Options.

3. Switch to the Exclude Files tab.
4

. In the list of file names, select C:\Program Files\Microsoft ADAM and click Remove. Click
OK.

5. When the Backup or Restore Wizard is displayed, clear the Always start in Wizard mode
checkbox and click Advanced Mode.

6. On the Welcome screen, click Backup Wizard.
7. On the Backup Wizard screen, click Next.

8. On the What to Backup screen, select Backup selected files, drives, or network data. Click
Next.

9. On the Items to Backup screen, select the folder containing the ADAM data as well as the
World Wide Web Publishing Service folder. Click Next.

The default location for the ADAM database is C:\Program Files\Microsoft
ADAM\AgfaHealthcare.

10. If backing up to a tape drive, under Backup media type, select the tape drive, and in the backup
media area, click New media. Click Next.

or

If backing up to any other media type, select the location where the backup is to be saved, and
type a name for the backup. Click Next.
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11. On the Completing the Backup Wizard screen, click Advanced.
12. On the Type of Backup screen, select Normal. Click Next.

13. On the How to Backup screen, select Verify data after backup and Use hardware compression
if available. Click Next.

14. On the Backup Options screen, select Replace the existing backups. Click Next.
15. On the When to Backup screen, select Now. Click Finish.

16. In the Backup Progress dialog, click Close.

17. Close the Backup Utility.

13. Converting the user data to LDF

(Topic number: 6719)

In IMPAX 6.5.1, user authentication, user preferences, and user permissions are stored in an ADAM
database or an external LDAP. Before the user data can be migrated from the IMPAX database into
the ADAM database, the exported MVF data must first be converted into XML (as described in
Exporting user data (refer to page 30)), then transformed into LDF (Layered Data Format).

To convert the user data to LDF
1. Open a command prompt.

2. Change to the C:\mvf-mig6\UserMigration directory.
3. Type
migrate-users.exe -m xml2ldf -I users.xml -d mvf_version_number -U

IMPAX_5.2_or_5.3_database_user -P IMPAX_5.2_or_5.3_database_password

Other parameters supported by this tool are listed in “migrate-users.exe” (topic number 10621) in
the IMPAX 6.5.1 Preparing to Upgrade Guide—IMPAX 4.5, 5.2, 5.3, or WEB1000 to IMPAX 6.5.1.

14. Migrating user data to ADAM

(Topic number: 6656)

To successfully migrate user data into ADAM, the user currently logged into the
IMPAX 6.5.1 Application Server component must have ADAM administrative rights. (To check,
launch ADAM Edit and select Role > member. The logged-in user must belong to the Administrator

group.)

To migrate user data to ADAM
1. Open a command prompt.

2. Change to the C:\mvf-mig6\UserMigration directory.
3. Type
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ldifde -i -s fully _qualified_domain_name_of ADAM_host -f LDF_input_file -t 636

where the LDF_input_file is the users.1df file produced by running the migrate-users.exe
command.

Tip:

To ignore the existing users, add the -k parameter to the Idifde command.

15. Backing up the ADAM database again

(Topic number: 6727)

All user data has been migrated to the ADAM database at this point. We recommend backing up
the ADAM database again—using a different backup name than used for any prior backup.
Instructions are available in Backing up the ADAM database (refer to page 54).

16. Updating ADAM passwords

(Topic number: 6715)

To successfully update ADAM passwords, ensure that the password policy has been modified as
described in Recording and disabling the password and account lockout policies (refer to page 31).

To update ADAM passwords
1. Open a command prompt.

2. Change to the C:\mvf-mig6\UserMigration directory.
3. Type

migrate-users.exe -m postimport -d mvf_version_number -U mvf -P mvf
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Upgrading
IMPAX Server software

Each IMPAX product (Server, Application Server, and Client) must be upgraded separately, starting
with the IMPAX Server.

If currently using a SQL Database Server, you can upgrade to IMPAX 6.5.1 by proceeding with the
Upgrading a SQL Database Server to IMPAX 6.5.1 (refer to page 36) tasks.

If currently using an Oracle Database Server, you can upgrade to IMPAX 6.5.1 by proceeding with
the Upgrading an Oracle Database Server to IMPAX 6.5.1 (refer to page 45) tasks.

1. Upgrading a SQL Database Server to IMPAX 6.5.1

(Topic number: 130362)

If currently using a SQL Database Server, you can upgrade to IMPAX 6.5.1 by proceeding with the
following tasks.

Backing up the AS300 SQL 2000 database

(Topic number: 11497)

IMPAX 6.5.1 cannot run on SQL Server 2000. If using that version, you must upgrade to SQL Server
2008. Before doing so, back up the 2000 database. The backup will then be restored in the new version
of SQL.

If using SQL Server 2005, you can stay with that version. You are not required to back up the database
at this point, but you can.

To back up the AS300 SQL 2000 database

1. Onthe server running the AS300 database, select Start > All Programs > Microsoft SQL Server
> Enterprise Manager.
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2. In the Explorer window of the Enterprise Manager, expand Console Root > Microsoft SQL
Servers > SQL Server Group > server > Databases > MVF

where server is the name of the SQL Server IMPAX is running under.

Select Action > All Tasks > Backup database.

In the SQL Server Backup screen, in the Backup section, select Database—complete.
Click Add and specify the directory to back up to.

To start the backup, click OK.

N Uy W

Exit the SQL Server Enterprise Manager.

Upgrading SQL Server 2000 to SQL Server 2008

(Topic number: 109391)

Before starting the upgrade from SQL Server 2000 to SQL Server 2008, ensure that you know the
SQL Server 2000 sa database password, as you must enter it as part of the upgrade. Also ensure that
you are logged into Windows as an administrator-level user.

Upgrading to SQL Server 2008 requires running the same installer used for a new install of SQL
Server 2008.

To upgrade SQL Server 2000 to SQL Server 2008

1. On the server you are upgrading, ensure that the Distributed Transaction Coordinator service
is running:

a. Open the Windows Administrative Tools and select Services.

b. Select the Distributed Transaction Coordination service. If this service is not started,
click Start Service.

2. Ensure that the SQLSERVERAGENT service is started.
3. To launch the installer, follow the instructions supplied with the SQL Server 2008 software.

4. When prompted, click OK and follow the on-screen instructions to install the Microsoft NET
Framework and updated Windows Installer. You might be asked to restart the server.

5. Inthe SQL Server Installation Center, select Installation, then select Upgrade from SQL Server
2000 or SQL Server 2005.
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Mew SQL Server stand-alone installation or add Features to an existing installation

Launch a wizard to install SQL Server 2008 in a non-clustered environment or to add features to an
existing SQL Server 2003 inskance,

Mew SQL Server Failover cluster installation

Launch a wizard ta install a single-node SGL Server 2008 Failover cluster,

Add node to & SQL Server Failover cluster
Launch a wizard to add a node to an existing SQL Server 2003 Failover cluster,

Upgrade from SQL Server 2000 or SQL Server 2005

Launch & wizard to upgrade SOQL Server 2000 or SQL Server 2005 to SQL Server 2008, Before you
upgrade, you should run the Upgrade Advisor to detect potential problems,

Search for product updates
Search Microsoft Update For SQL Server 2008 product updates,

6. On the Setup Support Rules screen, ensure that all operations have completed successfully.

Click OK.

7. On the next screen, enter the product key. Click Next.

8. When prompted, accept the Microsoft Software License Terms. Click Next.

9. On the Setup Support Files screen, click Install. After the support files are installed, click Next.

10. On the Setup Support Rules screen, ensure that all operations have completed successfully.

Click Next.

11. Inthe Select Instance screen, check that Instance to Upgrade has been set to MSSQLSERVER.

Click Next.
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12.
13.
14.
15.
16.
17.
18.
19.
20.
21.

& upgrade to SQL Server 2008 i ]
Select Instance
Specify the instance of SCL Server to modify.,
Setup Support Rules Select the instance of SQL Server ko upgrade, To upgrade only Management Tools and shared Features, select
"Upgrade shared features" and then click next,
Produck Key
License Terms Instance to upgrade:  |MSSQLSERVER j
Select Instance .
Installed instances:
Select Features
Instance Canfiguration Inskance Name Features Wersian Edition
il o Faaiem s M3SCLSERYER Server ComponentiSQL Server, Server ComponentiReplicati... |8.4.2039 Standard
ey £ e FiEmaing <Shared Components = | Management Tools\Enterprise Manager, Management Tools),.. |8.00.194
Upgrade Rules
Ready to Upgrade
Upgrade Progress
Complete
Mext = Cancel Help
4

On the Select Features screen, click Next.

On the Instance Configuration screen, click Next.

Verify that the disk space requirements have been met. Click Next.
On the Server Configuration screen, click Next.

On the Full-text Upgrade screen, keep the default and click Next.

On the Error and Usage Reporting screen, click Next.

On the Upgrade Rules screen, check that no errors appear. Click Next.
On the Ready to Upgrade screen, click Upgrade.

Verify that the upgrade was successful, then click Finish and Close.

Restart the computer.

When the computer restarts, log into Windows as an administrator-level user.

The next steps in the upgrade process are to stop the SQL Server services, then to install SQL Server
2008 SP1.

Stopping SQL Server 2008 services

(Topic number: 109422)

Before proceeding with the next task, stop the Windows SQL Server services, if they have been started.
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To stop SQL Server 2008 services
1. Open the Windows Administrative Tools.

2. Select Services.
3. Select each of the following services in turn and click Stop Service, if needed:
a. SQL Server Full Text Search
b. SQL Server Full Text Filter Daemon Launcher
c. SQL Server Browser
d. SQL Server Integration Services 10.0
e. SQL Server Integration

4. Close the Services window.

You can now install SQL Server 2008 SP1.

Upgrading SQL Server 2008 to SQL Server 2008 SP1

(Topic number: 107523)

The SQL Server 2008 SP1 executable file is SQLServer2008SP1-KB968369-x86-ENU.exe (32-bit).
You must acquire this file from Microsoft; for example, you can download it from the Microsoft
website at
http://www.microsoft.com/downloads/en/details.aspx?FamilylD=66ab3dbb-bf3e-4{46-9559-ccc6a4f9dc19

Before running the installer, ensure that you know the sa (system administrator) database password,
as you must enter it during the installation. Install the Service Pack after installing the software and
stopping the SQL services.

To upgrade SQL Server 2008 to SQL Server 2008 SP1
1. Launch the SP1 installer.

. If you see a security warning, click Run.
. On the Welcome screen, click Next.

2

3

4. On the License Terms screen, select I accept the agreement. Click Next.
5. On the Feature Selection screen, accept the default selections. Click Next.
6

. On the Check Files in Use screen, wait while the processes are identified. Then, click Next,
even if some locked files are found.

>

On the Ready to Update screen, click Update.

8. On the Update Progress screen, wait until the components are upgraded or installed, then click
Next.

9. If the Computer Reboot Required prompt appears, click OK.
This will not automatically restart the computer.
10. On the Installation Complete screen, click Close.

11. Restart the computer.
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When the computer restarts, log into Windows as an administrator-level user.

B caution

Do not attempt to start IMPAX at this point. If you start IMPAX now, the mvf user account will
be locked and you will not be able to log into the MVF database. If the mvf user account
becomes locked, see Troubleshooting: Unlocking the mvf user account (refer to page 74) for
instructions on how to unlock the account.

Upgrading the IMPAX SQL Server database schema to IMPAX 6.5.1

(Topic number: 7642)

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

Upgrading the database schema to 6.5.1 requires the IMPAX Migration Tools.

ﬂ CAUTION!

Any customization to the database—such as extra indexes, stored procedures, or triggers—may
affect the schema upgrade. We recommend removing such customizations prior to the upgrade.

To upgrade the IMPAX SQL Server database schema to IMPAX 6.5.1
1. Open a command prompt.

2. Change to the C:\mvf-mig6\bin directory.
3. If upgrading from IMPAX 6.5, type
database-upgrade-script.bat
If upgrading from IMPAX 6.2, 6.3, or 6.4, type
database-upgrade-script.bat -v {62 | 63 | 64}
If upgrading from IMPAX 5.2 or 5.3, type
database-upgrade-script.bat -U sa -P sapwd -v {52 | 53}
where sapwd is the password for the 5.2 or 5.3 sa (system administrator) user.
4. At the prompt
Ready to upgrade database to version 6.5.1. Do you want to proceed [y,n]?

Verify that the version_number listed is correct—for example, that it says 62 if upgrading from
IMPAX 6.2. If so, press Enter to continue.
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If the version is incorrect, type q and press Enter, then repeat the previous step with the correct
version number specified.

5. If prompted for the fully qualified host name of the login server, type the fully qualified host
name of this standalone station.

6. If prompted for a report source, in most cases, type UNKNOWN.
7. Respond appropriately to other prompts that appear.

The database is upgraded.

Checking the status of SQL Server upgrades

(Topic number: 9914)

After upgrading the database, check the log file to ensure that the upgrade was successful.

Important!

We recommend checking the migration log file after each leg of an upgrade before moving
onto the next leg.

To check the status of SQL Server upgrades
1. Open the log file C:\mvf-mig6\data\logs\migrate_database_to_IMPAX6.5.1.log
2. If the following warning appears in the log file, you can safely ignore it:

Warning: The table "CHANGE_CONTEXT_DETAIL®" has been created but its maximum
row size (8095) exceeds the maximum number of bytes per row (8060). INSERT
or UPDATE of a row in this table will fail if the resulting row length exceeds
8060 bytes.

3. Ensure that Migration Complete Successful appears at the end of the log file.

If this message does not appear, review the rest of the log file to see where the upgrade failed.
Solve the problem, then rerun the upgrade script.

Uninstalling the previous IMPAX software packages
(Topic number: 6744)

If you are upgrading an existing server, before installing the IMPAX 6.5.1 AS300 server packages,
uninstall the previous-version IMPAX packages.

To uninstall the previous IMPAX software packages
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Under Currently installed programs, select Agfa IMPAX 5.2 version, Agfa IMPAX 5.3 version,
AgfaIMPAX 6.2 version, AgfaIMPAX 6.3 version, or AgfaIMPAX AS300 (used for IMPAX 6.4
and later).
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Under Currently installed programs, select Agfa IMPAX 6.2 version, Agfa IMPAX 6.3 version,
or Agfa IMPAX AS300 (used for IMPAX 6.4 and later).

Click Change/Remove.
or

For uninstalling IMPAX 6.4 and later, click Remove.

. When prompted, type your name (minimum three characters). Click Next.

5
6.
7
8

In the Confirmation dialog, click OK or Yes.

. On the Maintenance Complete screen, click Finish.

. Restart the server.

After the server restarts, log into Windows as an administrator-level user.

Upgrading the IMPAX AS300 32-bit Database Server software

(Topic number: 6783)

To upgrade IMPAX AS300 software, you must be logged into Windows as an administrator-level

user.

Use the IMPAX installer to install the necessary packages on the system when upgrading an existing
IMPAX server, including standalone and single-server stations. Descriptions of the packages are
available in 32-bit AS300 installer packages reference.

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

To upgrade the IMPAX AS300 32-bit Database Server software

1.
2.
3.

Insert the IMPAX AS300 DVD.

Navigate to D:\programs\mvf and double-click as300-installer.exe.
Type your name (minimum three characters).

This information is recorded in the installer log file.

On the Welcome screen, click Next.

. On the Select features screen, all Default Packages are selected. Clear the checkboxes of any

packages that should not be installed.
Install all default packages except, potentially, the MVFocr package.
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6. Select the Database Packages label.

If upgrading under SQL Server, clear the Oracle Server Extension checkbox and select the
SQL Server Extension checkbox.

If upgrading an IMPAX 6.4 or later Oracle Database Server, confirm that the Oracle Server
Extension checkbox is selected.

7. Clear the Oracle Server Extension checkbox and select the SQL Server Extension checkbox.
8. Clear the Archive Packages checkbox.

9. Select the Optional Packages label, then select the checkboxes of any optional packages that
should be installed.

Appropriate Optional

packages to select
depends on the type of
server being installed.
Space Requeed on C: 108316 K
Space Avalabls on T 1133808 K

| rtatohaeld

Bk [ Net> | | coca |

Leave the MVFCompressor checkbox selected. If intending to export CDs from this station,
keep the MVFcdexport checkbox selected. Clear all other checkboxes.
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10. Click Next.
11. Browse to the location of the MVF license file and click OK.

If the mvflic file is not located in C:\mvf, the file is copied to that location. A dialog informs

you of the success of the copy task.
12. When prompted, type the password for the AgfaService user.
The password must follow the requirements outlined in .
13. To confirm that the database is compatible, click Yes.
14. On the Ready to begin installation screen, click Next.
The files are copied to the system.
15. To display the log file for the database scripts, when prompted, click No.
16. After all the packages have been installed, click Yes, I want to restart my computer now.

If you are not prompted to restart the computer, manually restart it.

When the computer restarts, log into Windows as an administrator-level user.

2.Upgrading an Oracle Database Server to
IMPAX 6.5.1

(Topic number: 130354)

If currently using an Oracle Database Server, you can upgrade to IMPAX 6.5.1 by proceeding with

the following tasks.

Applying patches and upgrading Oracle

(Topic number: 106570)

% Note:

This topic applies only when upgrading from IMPAX 6.4. If upgrading from IMPAX 6.5 or later,

this task can be skipped.

When upgrading an IMPAX AS300 Oracle server to IMPAX 6.5, apply the latest Oracle patches.

To apply patches and upgrade Oracle
1. Log into the Database Server as the Administrator.

2. Insert either the Oracle on Windows 32-bit DVD or the Oracle on Windows 64-bit DVD,
depending on the version of Windows running on the server.

3. Open a command prompt.

4. Change to the c:\mvf-mig6\bin directory.
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5. Type
bash upgrade-oracle location_of DVD_drive_or_Oracle_software_repository
For example,
bash upgrade-oracle d:

6. If the upgrade-oracle script aborts, it could be the due to permission problems.

To check for permission-related errors, navigate to the c:\mvf-mig6\data\logs\upgrade-oracle.log
file and search for an error similar to the following

SEVERE:Abnormal program termination. An internal error has occured. Please
provide the following files to Oracle Support :

""C:\oracle\102010\Inventory\logs\installActions2010-11-09 01-49-14PM.log"
""C:\oracle\102010\Inventory\logs\oralnstal 12010-11-09_01-49-14PM_err""
""C:\oracle\102010\Inventory\logs\oralnstal 12010-11-09_01-49-14PM_out""

If you see such an error, look in the specified .err file for the following:

Exception java.lang.NoSuchFieldError: numFailListEntries occurred..
jJava.lang.NoSuchFieldError: numFailListEntries
at
oracle_sysman.oii.oiip.osd.win32.0i ippWin32NativeCal Is._ssntSetPermissionsw32(Native
Method)

If you see a similar error, the error is permission related. In this case, reset the owner. Then,
open a command prompt and type takeown /f c:\oracle /r and run the upgrade-oracle command
again.

7. At the prompt Ready to upgrade Oracle using repository <Oracle software
location>. Do you want to proceed? [y/n]

Verify the Oracle software location. If the location is correct, type y and press Enter.
or
If an Oracle Data Guard configuration is detected, you are prompted to continue the upgrade

on the primary (or standby) server. Type y and press Enter.

Oracle is upgraded with the latest patches.

Upgrading the IMPAX Oracle database schema to IMPAX 6.5.1

(Topic number: 106573)

Run oracle-database-upgrade.bat to upgrade the IMPAX Oracle database schema to IMPAX 6.5.1.
On Oracle Data Guard systems, this procedure has to be done on the primary database only.

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).
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To upgrade the IMPAX Oracle database schema to IMPAX 6.5.1
1. Open a command prompt.

2. Change to the C:\mvf-mig6\bin directory.
3. Type
oracle-database-upgrade.bat
4. At the prompt Ready to upgrade database. Do you want to proceed [y,n]?, typey

and press Enter.

The database is upgraded.

Checking the status of Oracle upgrades

(Topic number: 110410)

After upgrading the database, check the log file to ensure that the upgrade was successful.

Important!

We recommend checking the migration log file after each leg of an upgrade before moving
onto the next leg.

To check the status of Oracle upgrades
. Navigate to the C:\mvf-mig6\data\logs directory.

1
2. Open the database_upgrade.log file.

3. Ensure that Migration Complete Successful appears at the end of the log file.
4

. If this message does not appear, review the rest of the log file to see where the upgrade failed.
Solve the problem, then rerun the upgrade script.

Uninstalling the previous IMPAX software packages
(Topic number: 6744)

If you are upgrading an existing server, before installing the IMPAX 6.5.1 AS300 server packages,
uninstall the previous-version IMPAX packages.

To uninstall the previous IMPAX software packages
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Under Currently installed programs, select Agfa IMPAX 5.2 version, Agfa IMPAX 5.3 version,
AgfaIMPAX 6.2 version, Agfa IMPAX 6.3 version, or AgfaIMPAX AS300 (used for IMPAX 6.4

and later).

Under Currently installed programs, select Agfa IMPAX 6.2 version, Agfa IMPAX 6.3 version,
or Agfa IMPAX AS300 (used for IMPAX 6.4 and later).
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Click Change/Remove.
or

For uninstalling IMPAX 6.4 and later, click Remove.

. When prompted, type your name (minimum three characters). Click Next.
. In the Confirmation dialog, click OK or Yes.
. On the Maintenance Complete screen, click Finish.

. Restart the server.

After the server restarts, log into Windows as an administrator-level user.

Upgrading the IMPAX AS300 32-bit Database Server software

(Topic number: 6783)

To upgrade IMPAX AS300 software, you must be logged into Windows as an administrator-level

user.

Use the IMPAX installer to install the necessary packages on the system when upgrading an existing
IMPAX server, including standalone and single-server stations. Descriptions of the packages are
available in 32-bit AS300 installer packages reference.

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

To upgrade the IMPAX AS300 32-bit Database Server software

1.
2.
3.

Insert the IMPAX AS300 DVD.

Navigate to D:\programs\mvf and double-click as300-installer.exe.
Type your name (minimum three characters).

This information is recorded in the installer log file.

On the Welcome screen, click Next.

. On the Select features screen, all Default Packages are selected. Clear the checkboxes of any

packages that should not be installed.
Install all default packages except, potentially, the MVFocr package.
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6. Select the Database Packages label.

If upgrading under SQL Server, clear the Oracle Server Extension checkbox and select the
SQL Server Extension checkbox.

If upgrading an IMPAX 6.4 or later Oracle Database Server, confirm that the Oracle Server
Extension checkbox is selected.

7. Clear the Oracle Server Extension checkbox and select the SQL Server Extension checkbox.
8. Clear the Archive Packages checkbox.

9. Select the Optional Packages label, then select the checkboxes of any optional packages that
should be installed.

Appropriate Optional

packages to select
depends on the type of
server being installed.
Space Requeed on C: 108316 K
Space Avalabls on T 1133808 K
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Leave the MVFCompressor checkbox selected. If intending to export CDs from this station,
keep the MVFcdexport checkbox selected. Clear all other checkboxes.
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10.
11.

12.

13.
14.

15.
16.

Click Next.
Browse to the location of the MVF license file and click OK.

If the mvflic file is not located in C:\mvf, the file is copied to that location. A dialog informs

you of the success of the copy task.

When prompted, type the password for the AgfaService user.

The password must follow the requirements outlined in .

To confirm that the database is compatible, click Yes.

On the Ready to begin installation screen, click Next.

The files are copied to the system.

To display the log file for the database scripts, when prompted, click No.

After all the packages have been installed, click Yes, I want to restart my computer now.

If you are not prompted to restart the computer, manually restart it.

When the computer restarts, log into Windows as an administrator-level user.

3. Migrating a cache volume from a flat to a

hierarchical structure

(Topic number: 102251)

Note:

If upgrading from IMPAX 6.5, the caches may have already been migrated to a hierarchical

structure; this task can then be skipped.

Before starting the migration, verify the condition of the caches:

1.
2.
3.

Install the MVFcachecheck package.
Run the mvf-clean-cache tool.

If the mvf-clean-cache output indicates that there are problems, resolve them.

IMPAX stores DICOM objects in cache so that they can be displayed, transmitted to other DICOM
devices, and archived. Prior to IMPAX 6.5, the cache structure was flat (each cache volume contained

one directory), which limited the cache size because once a certain number of objects are in the

directory, access to the cache can become very slow. Large sites may resolve this by deploying
numerous cache volumes, which can be difficult to manage.

As of IMPAX 6.5, a hierarchical cache structure is supported for image and web caches, permitting

larger cache volumes. The old flat cache structure continues to be supported; only new images
arriving in the system or existing images retrieved from archive are written to cache using the

hierarchical structure. However, the cache migration tool allows a site to migrate its existing caches
if it would like to immediately take advantage of the hierarchical structure.
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% Note:

The cache migration tool is included in the MVFCache (Windows) and IMPAXmvfc (Solaris)
packages, which are part of the standard IMPAX install packages.

To migrate a cache volume from a flat to a hierarchical structure
1. Ata command prompt on the system where the cache volume is local, type

cache_migration.exe parameters (Windows)

where parameters are as follows:

Parameters Values Default value

-S The cache volume to migrate from. If a source_volume_refis Not applicable
not specified, you are prompted to choose from a list. If the
destination volume is different from the source volume, make
sure that the source cache volume is closed before running the
cache-migration tool. When closed, new images cannot be
received by this volume, which will likely be removed after the
migration.

To close the cache volume, start the CLUI tool and type

cache close volume_ref

-D The cache volume to migrate to. It can be the same as the source Not applicable
volume. There should be enough space in the destination
volume for all the studies in the source volume. If a
destination_volume_ref is not specified, you are prompted to
choose from a list.

-X number—The delay in seconds before the original files are Not applicable
deleted. If not specified, the original files are not deleted. If 0,
the original files are deleted immediately.

-F number—The maximum number of cache files to be handled 100
by each thread in the application; a performance-tuning
parameter.
-T number—The number of threads to handle the copying of files; 3
a performance-tuning parameter.
-1 number—How often to report on the progress of the migration, 5
in minutes.
-f log_file—Log file name. Not applicable

Tip:

Use the -? parameter to view usage or help information.
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Example:

cache_migration.exe -F 500 -T 4 -1 2 -f migration.log
List of eligible cache volumes

1000 : /cache/mvfcache

1001 : /cache/vcacheRSNA2003

1002 : /cache/newcache

Source volume_ref? 1000

Destination volume_ref? 1000

Delete original files (Y/N)? vy

How long to wait to delete (sec)? 10

After the migration, verify the condition of the caches:
1. Run the mvf-clean-cache tool.
2. If the mvf-clean-cache output indicates that there are problems, resolve them.

For details about configuring the cache directory structure, see “Configuring the hierarchical cache
directory structure” (topic number 102687) in the IMPAX 6.5.1 Server Knowledge Base.
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Upgrading
IMPAX Application
Server software

Important!

Upgrading the IMPAX Application Server software applies only to upgrades from 6.2 and
later, since earlier versions did not include an Application Server component and you should
have already installed the IMPAX Business Services (refer to page 20).

After upgrading the IMPAX Server software and database, upgrade the IMPAX Application Server
by either upgrading the ADAM database (refer to page 53) for standalone stations on Windows XP,
or by upgrading the AD LDS database (refer to page 59) for standalone stations on Windows 7, and
then upgrading the Application Server software.

1. Upgrading the ADAM database

(Topic number: 58664)

Unlike previous versions of the IMPAX Application Server, you do not have to manually migrate
the ADAM database by running migrate.bat. Instead, the migration is performed automatically
during the software upgrade.

The results of the ADAM migration are recorded in the ImpaxAdam.log file in the C:\Impax\Logs
directory.
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Backing up the ADAM database

(Topic number: 6717)

The ADAM database maintains all the security around user profiles, access controls, and station
information on the Windows XP standalone station. Backing up the ADAM database at this time is
important prior to an Application Server upgrade or in advance of migrating user data into it.

To back up the ADAM database

1.

10.

11.
12.
13.

14.
15.
16.
17.

Select Start > All Programs > Accessories > System Tools > Backup.

2. Select Tools > Options.
3.
4. In the list of file names, select C:\Program Files\Microsoft ADAM and click Remove. Click

Switch to the Exclude Files tab.

OK.

When the Backup or Restore Wizard is displayed, clear the Always start in Wizard mode
checkbox and click Advanced Mode.

. On the Welcome screen, click Backup Wizard.
. On the Backup Wizard screen, click Next.
. On the What to Backup screen, select Backup selected files, drives, or network data. Click

Next.

. On the Items to Backup screen, select the folder containing the ADAM data as well as the

World Wide Web Publishing Service folder. Click Next.

The default location for the ADAM database is C:\Program Files\Microsoft
ADAM\AgfaHealthcare.

If backing up to a tape drive, under Backup media type, select the tape drive, and in the backup
media area, click New media. Click Next.

or

If backing up to any other media type, select the location where the backup is to be saved, and
type a name for the backup. Click Next.

On the Completing the Backup Wizard screen, click Advanced.
On the Type of Backup screen, select Normal. Click Next.

On the How to Backup screen, select Verify data after backup and Use hardware compression
if available. Click Next.

On the Backup Options screen, select Replace the existing backups. Click Next.
On the When to Backup screen, select Now. Click Finish.

In the Backup Progress dialog, click Close.

Close the Backup Utility.
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Stopping services on the Application Servers
(Topic number: 10144)

To ensure that IMPAX Client workstations do not attempt to connect during the upgrade process,
stop the Windows services on the Application Servers.

To stop services on the Application Servers
1. On an Application Server, open the Windows Administrative Tools and select Services.

2. In the list of services, highlight the World Wide Web Publishing Service.
3. Click Stop.
4. Repeat steps 2 and 3 for the following services:
a. IMPAX Distributed License Manager
IMPAX Messaging Service
IMPAX App Server Data Manager
IMPAX Audit Event Log Manager
IMPAX Dicom Object Sender
AGFA HealthCare Service

IS

- o a0

Uninstalling IMPAX 6.2 documentation

(Topic number: 10736)

You must uninstall the IMPAX 6.2 documentation before you can install the new IMPAX 6.5.1
documentation. Although the three IMPAX 6.2 Knowledge Bases are installed together, they must
be separately uninstalled.

To uninstall the IMPAX 6.2 documentation
Open Control Panel.

Select Add or Remove Programs.

Under Currently installed programs, select IMPAX 6.2 Documentation.

Click Change/Remove.

In the Confirmation dialog, click OK.

In the Maintenance Complete dialog, click Finish.

Under Currently installed programs, select IMPAX Application Server Knowledge Base.
Click Change/Remove.

Y ® N U D

In the Confirmation dialog, click OK.

—_
o

. In the Maintenance Complete dialog, click Finish.

[u—
[a—

. Under Currently installed programs, select Impax Client Knowledge Base.
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12. Click Change/Remove.

13. In the Confirmation dialog, click OK.

14. In the Maintenance Complete dialog, click Finish.

15. Under Currently installed programs, select IMPAX Server Knowledge Base.
16. Click Change/Remove.

17. In the Confirmation dialog, click OK.

18. In the Maintenance Complete dialog, click Finish.

Uninstalling IMPAX 6.3 or later documentation
(Topic number: 15533)

You must uninstall the IMPAX 6.3 or later documentation before you can install the new IMPAX 6.5.1
documentation.

To uninstall IMPAX 6.3 or later documentation
1. Open Control Panel.

2. In Windows XP, select Add or Remove Programs.

3. Inthe Programs and Features dialog, under Currently installed programs, select AGFA IMPAX
version Knowledge Base buildnumber Documentation.

4. Click Remove.
5. In the confirmation dialog, click OK.

A progress dialog appears as the documentation is uninstalled, giving the amount of time
remaining. When the process is complete, the dialog closes.

6. Close the Programs and Features dialog.

All installed IMPAX documentation for the version selected is uninstalled.

Upgrading the IMPAX Application Server software to 6.5.1

(Topic number: 9863)

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

After backing up the ADAM database (refer to page 54), you can upgrade the Application Server
software.
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E Note:

This installation does not overwrite the existing ADAM database.

To upgrade the IMPAX Application Server software to 6.5.1
1. Insert the IMPAX Business Services CD.

2. Navigate to the CD ROM drive, which contains the Business Services software.
3. Run AGFA IMPAX Business Services Setup.exe.
The following packages are installed on the Application Server prior to the upgrade.

* Visual JSharp .NET 2.0
« .NET Framework 3.5 SP1

* Visual C++ 9.0 SP1 ATL Update (x86)

If any of these packages are listed in the InstallShield Wizard dialog, they are installed
when you click Install. If any of these packages do not appear in the list, those packages
are already installed on the machine.

Installshield Wizard

O AGFA IMPAX Business Services 6.5.0.1361 requires the following items ta be installed on
L="1 your computer. Click Install to beqgin instaling these requirements.

Statuz | Requirement |
Pending “izual JSharp NET Rediztributable Package 2.0
Fending “izual C++ 3.0 5P1 ATL Update [«8E)

Install Cancel

Click Install.
On the Welcome screen, click Next.
On the license agreement screen, select I accept the terms in the license agreement. Click Next.

On the Web Services Installation Folder screen, click Change.

® N e

Set the path to the wwwroot directory so that it matches the pre-upgrade installation location.
Click OK.

For example, set the path to J:\\wwwroot rather than C:\inetpub\wwwroot.

9. Click Next.
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10.
11.
12.

13.
14.
15.

16.

17
18

On the Setup Type screen, select Custom. Click Next.
On the RIS screen, click Next.

If you are using SmartCard authentication, verify that NHS SmartCard Web Services is selected.
If it is not selected, select it. Select This feature will be installed on local hard drive.

Click Next.
Click Install.

On the InstallShield Wizard Completed screen, select Launch IMPAX Business Services
Configuration tool. Click Finish.

When the message Previous configuration found from version 6.X.X... appears,click
Yes. This message is not displayed when upgrading from IMPAX 6.5 to IMPAX 6.5.1.

. In the Configuration Tool, click Apply.
. To close the Configuration Tool, click OK.

The Application Server software is upgraded.

Installing the IMPAX documentation

(Top

ic number: 15523)

Before installing the IMPAX 6.5.1 documentation, ensure that you have uninstalled any earlier
IMPAX documentation (refer to page 17).

IMPAX is shipped with three sets of documentation: the IMPAX 6.5.1 Client Knowledge Base:
Extended and related guides, the IMPAX 6.5.1 Application Server Knowledge Base and related guides,
and the IMPAX 6.5.1 Server Knowledge Base and related guides. The IMPAX documentation set
appears on its own installation DVD.

Toi

1.
2.

nstall the IMPAX documentation
Insert the IMPAX Documentation DVD.

From the DVD root, double-click IMPAXDocumentationSetup.exe.

A Preparing to install message appears.

3. On the Welcome screen, click Next.
4. On the Setup Type screen, select the appropriate option and click Next.
+ To install all documentation in all available languages (up to 24 languages), select All
Documentation.
+ To install all English-language documentation, select All English Documentation. This
is the default.
+ To select which documentation to install in which languages, select Select Documentation
to Install.
5. If you selected Select Documentation to Install, on the Choose Features screen, you can select
particular Knowledge Bases or languages to install.
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+ To install the IMPAX Client Knowledge Base in two or more languages, click & -] beside
the name of the language to install and select This feature will be installed on the local
hard drive. (Note that English must be installed.)

+ To not install the IMPAX Server, IMPAX Application Server, or IMPAX Client
documentation, click i=~] beside the appropriate label and select This feature will not
be available.

6. On the Ready to Install the Program screen, click Install.

Installation progress messages are displayed.
7. On the InstallShield Wizard Completed screen, click Finish.
The selected IMPAX documentation is now installed. Shortcuts appear in the Start menu and on

the desktop. For additional details on viewing the translated documentation on the IMPAX Client
see Viewing translated documentation from the IMPAX Client Help menu

2.Upgrading the AD LDS database from IMPAX 6.5
to IMPAX 6.5.1

(Topic number: 130063)

Unlike previous versions of the IMPAX Application Server, the AD LDS database must be migrated
when upgrading from IMPAX 6.5 to 6.5.1. The migration is performed automatically during the
software upgrade.

The results of the AD LDS migration are recorded in the ImpaxAdam.log file in the C:\Impax\Logs
directory.

Creating a one-time backup of AD LDS

(Topic number: 113662)

On Application Servers running Windows Server 2008, all IMPAX user information is stored in the
AD LDS database.

Backing up the AD LDS database at this time is important in the event that user migration fails.

Follow this procedure to create a one-time backup of the AgfaHealthcare AD LDS instance.

To create a one-time backup of AD LDS

1. To open an elevated command prompt, click Start, right-click Command Prompt and select
Run as administrator.

2. At the command prompt, type
dsdbutil
3. At the dsdbutil prompt, type

activate instance AgfaHealthcare
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4. At the dsdbutil prompt, type

ifm

. At the ifm prompt, type

create full location

where location is the path to the folder where you want the installation media to be created.
You can save the installation media to a network shared folder or to any other type of removable
media.

Example:

ifm: create full C:\Backup\AgfaHealthcare

. At the ifm prompt, type

quit
At the dsdbutil prompt, type
quit

The AD LDS instance is backed up.

Stopping services on the Application Servers
(Topic number: 10144)

To ensure that IMPAX Client workstations do not attempt to connect during the upgrade process,
stop the Windows services on the Application Servers.

To stop services on the Application Servers

1.
2.
3.

On an Application Server, open the Windows Administrative Tools and select Services.
In the list of services, highlight the World Wide Web Publishing Service.
Click Stop.

. Repeat steps 2 and 3 for the following services:

a. IMPAX Distributed License Manager
b. IMPAX Messaging Service

. IMPAX App Server Data Manager
IMPAX Audit Event Log Manager

e. IMPAX Dicom Object Sender

f. AGFA HealthCare Service

[g)

o
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Uninstalling IMPAX 6.3 or later documentation
(Topic number: 15533)

You must uninstall the IMPAX 6.3 or later documentation before you can install the new IMPAX 6.5.1
documentation.

To uninstall IMPAX 6.3 or later documentation
1. Open Control Panel.

2. In Windows XP, select Add or Remove Programs.

3. Inthe Programs and Features dialog, under Currently installed programs, select AGFA IMPAX
version Knowledge Base buildnumber Documentation.

4. Click Remove.
5. In the confirmation dialog, click OK.

A progress dialog appears as the documentation is uninstalled, giving the amount of time
remaining. When the process is complete, the dialog closes.

6. Close the Programs and Features dialog.

All installed IMPAX documentation for the version selected is uninstalled.

Upgrading the IMPAX Application Server software to 6.5.1

(Topic number: 126080)

Important!

Only specific IMPAX upgrade paths are supported, and it may not be possible to upgrade
certain versions or SUs. More information is provided in Valid IMPAX upgrade paths (refer to
page 10).

After backing up the ADAM database (refer to page 54), you can upgrade the Application Server
software.

E Note:

This installation does not overwrite the existing ADAM database.

To upgrade the IMPAX Application Server software to 6.5.1
1. Insert the IMPAX Business Services CD.

2. Navigate to the CD ROM drive, which contains the Business Services software.
3. Click Install.
4. On the Welcome screen, click Next.
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10.
11.

12.
13.
14.

15.
16.

On the license agreement screen, select I accept the terms in the license agreement. Click Next.

. On the Web Services Installation Folder screen, click Change.

Set the path to the wwwroot directory so that it matches the pre-upgrade installation location.
Click OK.

For example, set the path to J:\wwwroot rather than C:\inetpub\wwwroot.

. Click Next.

On the Setup Type screen, select Custom. Click Next.
On the RIS screen, click Next.

If you are using SmartCard authentication, verify that NHS SmartCard Web Services is selected.
If it is not selected, select it. Select This feature will be installed on local hard drive.

Click Next.
Click Install.

On the InstallShield Wizard Completed screen, select Launch IMPAX Business Services
Configuration tool. Click Finish.

In the Configuration Tool, click Apply.
To close the Configuration Tool, click OK.

The Application Server software is upgraded.

Installing the IMPAX documentation

(Topic number: 15523)

Before installing the IMPAX 6.5.1 documentation, ensure that you have uninstalled any earlier
IMPAX documentation (refer to page 17).

IMPAX is shipped with three sets of documentation: the IMPAX 6.5.1 Client Knowledge Base:
Extended and related guides, the IMPAX 6.5.1 Application Server Knowledge Base and related guides,
and the IMPAX 6.5.1 Server Knowledge Base and related guides. The IMPAX documentation set
appears on its own installation DVD.

To install the IMPAX documentation

1.
2.

Insert the IMPAX Documentation DVD.
From the DVD root, double-click IMPAXDocumentationSetup.exe.
A Preparing to install message appears.
On the Welcome screen, click Next.
On the Setup Type screen, select the appropriate option and click Next.
+ To install all documentation in all available languages (up to 24 languages), select All

Documentation.

+ To install all English-language documentation, select All English Documentation. This
is the default.

Standalone Upgrade Guide—IMPAX 6.5.1 62
Agfa Company Confidential—Subject to Non-Disclosure Obligation



+ To select which documentation to install in which languages, select Select Documentation
to Install.

5. If you selected Select Documentation to Install, on the Choose Features screen, you can select
particular Knowledge Bases or languages to install.

+ To install the IMPAX Client Knowledge Base in two or more languages, click & -] beside
the name of the language to install and select This feature will be installed on the local
hard drive. (Note that English must be installed.)

+ To not install the IMPAX Server, IMPAX Application Server, or IMPAX Client
documentation, click i=~] beside the appropriate label and select This feature will not
be available.

6. On the Ready to Install the Program screen, click Install.
Installation progress messages are displayed.

7. On the InstallShield Wizard Completed screen, click Finish.

The selected IMPAX documentation is now installed. Shortcuts appear in the Start menu and on
the desktop. For additional details on viewing the translated documentation on the IMPAX Client
see Viewing translated documentation from the IMPAX Client Help menu

3.Running Healthcheck from a URL to check the
status of web services

(Topic number: 11405)

Healthcheck checks the status of each web service running on the Application Server. When you
run Healthcheck, it attempts to connect to each of the web services. If it succeeds, Healthcheck sets
the status to Passed (green) @ . If Healthcheck fails, the status is set to Failed (red) @ .The comment

field indicates where the failure occurred.

% Note:

Healthcheck verifies only installed services. It does not indicate if a service is not installed.

To run Healthcheck from a URL to check the status of web services
1. Ensure that the Healthcheck web.config file has been configured to the site’s needs.

2. On the standalone station, launch Internet Explorer.
3. In the address bar, if Healthcheck has not been configured to automatically log in, type
https://fully_qualified_domain_name/AgfaHC.Healthcheck.Escrow
or
If Healthcheck has been configured to automatically log in, type
https://fully_qualified_domain_name/AgfaHC.Healthcheck.Escrow/EscrowForm.aspx

Standalone Upgrade Guide—IMPAX 6.5.1 63
Agfa Company Confidential—Subject to Non-Disclosure Obligation



To Append Example

View the results in tformat=html to the end https://appserver.hospital.com/
HTML of the URL AgfaHC.Healthcheck.Escrow/
EscrowForm.aspx?format=html

Add a refresh frequency ?refresh=seconds to the https://appserver.hospital.com/
end of the URL AgfaHC.Healthcheck.Escrow/
EscrowForm.aspx?refresh=60

View the results in format=html&refresh= https://appserver.hospital.com/
HTML and add arefresh seconds to the end of the AgfaHC.Healthcheck.Escrow/
frequency in the same  URL EscrowForm.aspx?format=
URL html&refresh=60

ﬂ CAUTION!

Setting the refresh interval below five seconds impacts performance.

4. If Healthcheck has not been configured to automatically log in, type an IMPAX Administrator
username and password, select the login domain, and click Log in.

On the Agfa Web Services: Healthcheck page, all web services are listed with a status of Passed
(green) @ or Failed (red) @ .

5. To determine what the problem is for any web services with the status Failed, review the
Comments.

6. To check the status of the web services again, in Internet Explorer, click Refresh.
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Installing and
configuring the
IMPAX Client software

Complete the IMPAX Client software upgrade tasks after upgrading and initially configuring the
IMPAX Server and IMPAX Business Services software.

1. Installing Windows 7 SP1

(Topic number: 130089)

If using Windows 7, we recommend installing Service Pack 1.

To install Windows 7 SP1

1.
2.

Right-click Computer and select Properties.

If Service Pack 1 is listed under Windows Edition, you do not have to install it.

To install Windows 7 SP1

1.

Go to
hitp/mwwwmicrosoft.com/downloads/en/detailsaspx?FamilyID=c3202ce6-4056-4059-8a1b-3a9b77cdfdda&displaylang=en

. Click Continue.

. Choose either the 32-bit (x86) or the 64-bit (x64) version of SP1 depending on whether you

are running the 32-bit or the 64-bit version of Windows 7.

To find out which version you are running, right-click Computer and select Properties. Under
System, next to System type, you can view the operating system.

Click Download.
To install SP1 immediately, click Open or Run.
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6. Follow the instructions on your screen.
7. On the Install Windows 7 Service Pack 1 page, click Next.
8. Follow the instructions on your screen.
Your computer might restart during the installation.
9. After the installation completes, log on to your computer at the Windows logon prompt.

You might see a notification indicating whether the update was successful.

2. Manually uninstalling the IMPAX 5.2 or 5.3 Client
software

(Topic number: 51525)

IMPAX 5.2 or 5.3 Client software must be uninstalled before the IMPAX 6.5.1 Client software can
be installed.

To manually uninstall the IMPAX 5.2 or 5.3 Client software
1. Open Control Panel.

Select Add or Remove Programs.

Under Currently installed programs, select IMPAX Client ES and click Remove.
At the Are you sure you want to remove this program? prompt, click Yes.
If a Files Not Removed dialog opens, to remove the remaining files, click Yes.

At the Uninstall Successful message, click OK.

Restart the computer.

® N Nk w D

After the computer has restarted, verify that the C:\mvf directory has been deleted. If the
directory is still present, delete it.

3.Installing the IMPAX Client

(Topic number: 7776)

The following explains how to install IMPAX Client using the default InstallShield package. An
alternative is to automate the installation through a batch file. For instructions on installing
IMPAX Client that way, refer to “Enabling automated installation of the IMPAX Client software
from a command prompt” (topic number 7802) in the IMPAX 6.5.1 Client Installation, Upgrade,
and Configuration Guide.

E Note:

To install the IMPAX Client, you must be logged in as a user in a Administrators role that has
permissions to the Windows Services.
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To install the IMPAX Client
1. From the IMPAX Client CD or the IMPAX Client Installation web page
(https://install_server_name/clientinstaller/language_code), start the IMPAX Client installation
program, IMPAXClientSetup.exe.

For information on setting up a Client installation server, refer to “Installing the IMPAX
Installation Server” (topic number 7773) in the IMPAX 6.5.1 Client Installation, Upgrade, and
Configuration Guide or the IMPAX 6.5.1 Preparing to Upgrade Guide—IMPAX 4.5, 5.2, 5.3, or
WEB1000 to IMPAX 6.5.1.

B caution

Do not use a standalone IMPAX workstation as an IMPAX Client Installer server. Instead,
place the IMPAX Client Installer server program on another server.

2. If a File Download dialog appears, click Open or Run.
A Preparing to Install message appears.
3. If a prompt appears about downloading and installing missing components, click OK.

4. Follow the prompts to download and install Microsoft .NET Framework 3.5, Microsoft .NET
Framework 3.5 SP1, or all.

E Note:

After installing a component, the installer may stop running or you may receive an
Installation is not yet complete message. In either case, rerun the
IMPAXClientSetup.exe program.

Depending on network speed, downloading and installing the Microsoft NET Framework can
take over 30 minutes.

For the .NET Framework 3.5 install, after the download, agree to the installation, accept the
license agreement, and after the installation is complete click OK. If prompted, restart the
computer.

If you do not have a live Internet connection, the downloading will not work. Instead, install
the Microsoft NET Framework 3.5 from the Client Installer server
(https://install_server_name/clientinstaller/redist/dotnetfx35.exe).

For the .NET Framework 3.5 SP1 install, after the download, if prompted to start the installation,
click OK. If prompted, restart the computer.

5. On the Welcome to the InstallShield Wizard for IMPAX Client screen, click Next.

6. On the License Agreement screen, read the license agreement. If you agree, select I accept the
terms in the license agreement. Click Next.

7. To install the application into C:\Program Files\Agfa\IMPAX Client, on the Destination Folder
screen, click Next.

or
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To install the application to another location, click Change. In the Change Current Destination
Folder dialog, browse for the directory location to install into and click OK. On the Destination
Folder screen, click Next.

8. On the IMPAX Application Server screen, in the Get or confirm application server name field,
type the fully qualified domain name of this standalone station. Click Next.

A fully qualified domain name is the full name of a system, including its local host name and
complete domain name. For example, if the standalone station is called gastation, it is on the
network domain called radnet, and radnet is within the healthorg.com domain, the name to
type would be gastation.radnet.healthorg.com.

9. On the IMPAX Login Type screen, select the appropriate authentication method: Windows,
IMPAX, or Smart Card.

+ Windows Authentication—Logs into IMPAX using the Windows session credentials

after launching the IMPAX Client or logging in with a Windows smart card.

+ IMPAX Authentication—Logs into the IMPAX Client separately from Windows. (If
unsure of which option to select, use IMPAX Authentication.)

+ Smart Card Authentication—Logs into the IMPAX Client with a smart card in the
National Health Service (NHS) environment only.
10. Click Next.
11. On the Ready to Install the Program screen, click Install.
The program is installed.

12. On the InstallShield Wizard Completed screen, click Finish.

The IMPAX Client software is installed. You do not have to restart the computer.

4. Installing related Client software

(Topic number: 7661)

The following software packages can be integrated with the Client software. Which of these you need
to install depends on who will be using the workstation, where the workstation is located (within or
outside the network firewall), and what licenses are available at your site.

* Voxar 3D—Fully integrated application used for 3D, MPR, and MIP modeling and analysis.

* Orthopaedic Application software—Used for applying digital templates and completing
measurements in preparation for orthopaedic surgery. This software is available on a separate
installation CD and requires a hardware dongle.

For instructions on installing these software packages, refer to the topic “Installing related software”
(topic number 7779) in the IMPAX 6.5.1 Client Installation, Upgrade, and Configuration Guide. If
upgrading from IMPAX 6.2 or later, this software may already be installed.
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5. Restarting antivirus software

(Topic number: 9916)
If you have antivirus software installed and have halted any scan jobs, restart the antivirus services.

To restart antivirus software
1. On a Windows server where scanning was stopped, launch the antivirus software.

2. Start the scan operation according to the vendor’s instructions.

6. Renaming and assigning Client licenses

(Topic number: 7629)

Important!
This topic applies only when upgrading an existing IMPAX 5.2 or 5.3 server to 6.5.1.

Client license files have generic names that do not clearly identify their purpose. Use the License
Manager Administrator Tool to give the license file a unique name that describes the role or abilities
associated with this license. For example, the name can be changed to IMPAX Administrator or to
Radiologist.

To rename and assign Client licenses

1. Select Start > All Programs > Agfa Healthcare > Business Services > License Manager
Administrator Tool.

2. Ensure that you are at the C:\Program Files\Agfa\Impax Business Services\Licensing Admin
Tool prompt.

3. At the prompt, type almadmin -setAdminName serial "name"

where serial is the serial number of the license to be renamed and name is the new name for
the license. For example, type almadmin -setAdminName 1234567 "Entry Level Radiologist".

4. To close the License Manager Administrator Tool, type exit and press Enter.

You can then assign licenses to roles in the Client. A role is collection of users or other roles
that holds permissions and preferences as well as licensing options. For example, a role can
represent the enterprise, the institution, a department, or a team.

5. In the IMPAX Client, assign the license to the appropriate roles.

Refer to “Assigning licenses to roles” (topic number 9353) in the IMPAX 6.5.1 Client Knowledge
Base: Extended.
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Note:

When a license has been installed though the ALMadmin tool, then assigned to a role in the
IMPAX Client, it may take up to 15 minutes before the users in that role can log into the
system.

7.Completing other IMPAX Client configuration

tasks

(Topic number: 7730)

Important!

When upgrading a standalone station from IMPAX 6.2 or later, key Client settings are migrated
and do not have to be reconfigured.

When first implementing IMPAX at a site, the PACS Administrator must complete many other
Client configuration tasks. These include:

Configuring the workstation settings, including monitors

Defining roles and users, including permissions and operations

Operation defaults can differ between an install and upgrade of the Client. Check the settings
for the operations to ensure the appropriate access to features is given.

Creating and adding worklists

Defining relevance rules for opening priors

+ Setting hanging protocols for viewing studies (for radiologists)

Configuring modality and body part preferences, including Image area tools

Configuring DICOM printers and printing

+ Readying image wizards and enabling preconfigured ones

Defining the dictation workflow (for radiologists)

Setting up logging of system activity

Information on how to complete these tasks is provided in the IMPAX 6.5.1 Client Knowledge Base:
Extended, “Administering IMPAX” section (topic number 11588).
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Troubleshooting IMPAX

As you upgrade IMPAX servers, you may encounter various problems.

Troubleshooting: Web services do not run after
installing or upgrading the Application Server

(Topic number: 118488)

Issue

After installing or upgrading the Application Server, web services do not start and applications such
as the Configuration Tool do not run.

Details

During installation, InstallShield may have failed to install all the necessary files.

Solution

1. Check that all the expected files are present in the Web Services directory on the Application
Server. Also check that the C:\Program Files\Agfa\Impax Business Services\Configurator
directory is present and that this directory contains more than a few files.

2. If some of the files are missing from the Web Services directory, or if the C:\Program
Files\Agfa\Impax Business Services\Configurator directory is missing or contains just a few
files, run the Business Services installation program again and select the Repair option.

3. If the procedure you ran in the preceding step fails, uninstall (refer to page 82) and then
reinstall the Application Server.
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Important!

If you have to reinstall the Application Server, do not reinstall the ADAM or AD LDS database.

Troubleshooting: Application Server is unavailable
after reinstalling IS

(Topic number: 7743)

Issue
The Application Server is unavailable after IIS is uninstalled and reinstalled, and does not respond.

Details

The Microsoft Distributed Transaction Coordinator service must be running before IIS is reinstalled
on a standalone station where the IMPAX Business Services component has already been installed.

To confirm the problem

1. Open the Windows Administrative Tools and select Internet Information Services (IIS)
Manager.

2. Expand computer_name (local computer) > Web Sites.
3. Navigate to Default Web Site > iisstart.asp.
4. Right-click iisstart.asp and select Browse.

If a problem exists, an Internal Server Error message is returned.

Solution

To determine whether IIS was reinstalled successfully
1. Open the Windows Administrative Tools and select Component Services.

2. Navigate to Component Services > Computers > My Computer > COM+ Applications.
3. Ensure that the following COM+ Applications are listed:
+ IS In-Process Application

+ IIS Out-Of-Process Pooled Applications
« IIS Utilities
4. If the IIS applications are not listed, enable the Distributed Transaction Coordinator service

and reinstall IIS.

To enable the Distributed Transaction Coordinator service
1. Open the Windows Administrative Tools and select Services.
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2. Right-click Distributed Transaction Coordinator and select Properties.
3. On the General tab, from the Startup type list, select Automatic.
4. Click Start. Click OK.

Troubleshooting: Unsure whether certificates are
installed

(Topic number: 7698)

Issue

Unsure whether certificates are installed.

Details

Solution

You can determine whether the certificates have been installed properly using the following steps.

To check whether any certificates are installed

1. Open the Windows Administrative Tools and select Internet Information Services (IIS)
Manager.

2. Expand computername > (local computer) > Web Sites.
3. Right-click Default Web Site and select Properties.
4. Switch to the Directory Security tab.

The installed certificate can be viewed using the View Certificate button. If the View Certificate
button is disabled, no certificate is installed.

To use Console Management to check which certificates are installed
Open a command prompt.

Type mmc.

In the Consolel window, select File > Add/Remove Snap-in.

In the Add/Remove Snap-in dialog, click Add.

In the Add Standalone Snap-in dialog, from the list, select Certificates.
Click Add.

In the Certificates snap-in dialog, select Computer account. Click Next.
Click Finish.

The certificate is added for the Computer account and appears in the list in the Add/Remove
Snap-in dialog.

9. In the Add Standalone Snap-in dialog, click Add again.

® N Nk » D=
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10. In the Certificates snap-in dialog, select Service account. Click Next.
11. Click Next again.

12. From the Service account list, select Agfa Healthcare.

13. Click Finish.

The certificate is added for the Service account and appears in the list in the Add/Remove
Snap-in dialog.

14. In the Add Standalone Snap-in dialog, click Close.
15. Click OK.

To view whether the certificates are installed for the proper accounts
1. Inthe Console Root window, expand Certificates (Local Computer) > Personal > Certificates.

On the right pane, the certificate should be issued to machinename.fully_qualified_domain_name.
2. On the left pane, expand Trusted Root Certification Authorities > Certificates.
On the right pane, the certificate issued by the certificate authority should appear in the list.

3. Repeat steps 1 and 2 for Certificates-Service (Agfa Healthcare) >
ADAM_AgfaHealthcare\Personal and ADAM_AgfaHealthcare\Trusted Root Certification
Authorities.

Tip:

In case you ever need to check on installation again, in the Console window, choose File >
Save As to save the certificates as an MSC file.

Troubleshooting: Unlocking the mvf user account

(Topic number: 114829)

Issue
You cannot log into SQL Server 2008 using the mvf account because the mvf user account is locked.

Details

The mvf user account gets locked if you start IMPAX immediately after upgrading to SQL Server
2008 SP1.

Solution

To unlock the mvf user account
1. Log into SQL Server 2008 using the Administrator account.

2. In the SQL Server Management Studio, open a new query window.
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3. Type
ALTER LOGIN mvf ENABLE;
ALTER LOGIN mvf with PASSWORD = 'mvf' UNLOCK;
GO

4. Click Execute. p

Troubleshooting: Installation of IMPAX software
unsuccessful; must reinstall packages

(Topic number: 7685)

Issue
IMPAX Server was not installed successfully.

Details

If the IMPAX Server software installation was not successful, you may have to uninstall the IMPAX
software and retry the IMPAX installation.

Solution

Before retrying the installation, attempt to determine why the installation failed and correct the
problem, if possible. You can find specific error messages and more information on the installation
in these log files:

+ C:\mvf\data\logs\mitra_install.log

+ C:\mvf\data\logs\build_mvf.log

+ C:\mvf\data\logs\build-database.log
+ C:\mvf\data\logs\add_impax_mvf.log

After the problem is determined and resolved, reinstalling the IMPAX software requires four steps:
1. Restart the system as indicated by the installer, even if failures have occurred.
2. Determine whether the security components were applied.

If the installation failed after the security components were applied, you must log in using the
AgfaService account to reinstall the IMPAX software. If the installation failed before the security
components were applied, you must log in as a Windows administrator to reinstall the IMPAX
software. Refer to the instructions that follow.

3. Uninstall the IMPAX software.

4. Install the IMPAX packages again, using the correct user account.

To uninstall the IMPAX software
1. Open Control Panel.
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9.
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Select Add or Remove Programs.

Select AGFA IMPAX AS300.

Click Change.

At the prompt, type your name and click Next.

On the Welcome screen, select Modify. Click Next.

Clear the checkboxes of all installed packages. Click Next.

On the Maintenance Complete screen, select Yes, I want to restart my computer now and
click Finish.

Important!

Do not manually delete the C:\mvf folder as part of the uninstall. If you do, you will have
to re-create and reimport the portable password files.

Log into Windows as the AgfaService user.

You can then reinstall the IMPAX packages.

Troubleshooting: Confirming that the correct IMPAX
Server packages are installed

(Topic number: 100280)

You can determine whether the correct IMPAX Server packages have been installed using the following
steps.

To confirm that the correct IMPAX Server packages are installed

1.

Open Control Panel and select Add or Remove Programs.

2. Select AGFA IMPAX AS300 and click Change.
3. After the installer launches, click Modify.

4.
5

Click Next.

. Verify that the list of installed packages is correct and remove any if necessary.

If necessary, uninstall IMPAX 6.5.1 Server (refer to page 83) and reinstall.

Standalone Upgrade Guide—IMPAX 6.5.1 76
Agfa Company Confidential—Subject to Non-Disclosure Obligation



Troubleshooting: Server license keys do not work

(Topic number: 7649)

Issue

Programs do not start because of Server license key problems.

Details

Server license keys can present problems if they are not stored in the correct directory or are not
matched to the MAC addresses of the machines. To function properly, the correct number of license
keys must be located in the correct directory.

Solution

Ensure that the appropriate license keys are installed in the correct location. Information on obtaining
a MAC address is available in Obtaining Server license keys (refer to page 11).

To install the mvf license key
1. Match up the correct license key with the machine’s MAC address.

The license key name is the MAC address with a .lic file extension.
2. Open Windows Explorer.
3. Copy the license key file to the mvf directory on the hard drive.
4. Rename the license key file to mvf.lic.

Troubleshooting: Receiving errors when installing
the MVF SQL database software

(Topic number: 7640)

Issue
You receive error messages when installing the MVF AS300 packages with the SQL Server Extension.

Details

If an error occurs while installing the SQL MVF database, it may relate to the security components
not being applied, which requires reinstalling the software. Otherwise, you can try rebuilding the
database.
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Solution

To determine if the security components were applied

1.
2.
3.

On the Database Server, open a command prompt.

Type sqlcmd -E.

Note whether the response is a failure message.

If this fails, the security components have been installed but not applied.

If the command failed, rebuild the database.

To rebuild the database

1.

Select Start > All Programs > Microsoft SQL Server 2008, right-click SQL Server Management
Studio and select Run as.

. In the Connect to Server dialog, select Windows Authentication in the Authentication field.

3. From the User name list, select AgfaService.

8.
9.
10.

In the Password field, type the password for the AgfaService account and click OK.
The SQL Server Enterprise Manager is opened using the AgfaService account permissions.
In the Object Explorer window of the Management Studio, expand server > Databases

where server is the name of the SQL Server that IMPAX is running under.

. Right-click the MVF database and select Stop.

To confirm stopping the database, click Yes.

Stopping the database may take a few minutes.
Right-click the MVF database again and select Delete.
To confirm the deletion of the database, click Yes.

Run the build-mvf-sqlserver-database script.

If you receive an error a second time, contact your vendor.

Troubleshooting: After installing IMPAX AS300
Server packages, SQL Server does not start

(Topic number: 59020)

Issue

After installing the IMPAX AS300 Server packages and restarting the server, the SQL Server 2005
service does not start.

Details
This problem happens intermittently under Windows XP SP3, when using SQL Server 2005 SP2.
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Solution

If the SQL Server 2005 service does not start after installing the AS300 Server packages and restarting
the system, follow these steps to start them manually.

1.

N LN

Open the Windows Administrative Tools and select Services.

In the list of services, right-click SQL Server (MSSQLSERVER) and select Properties.
In the Properties dialog, from the Startup type list, select Manual. Click OK.
Right-click the SQL Server (MSSQLSERVER) service name again and select Start.
Right-click SQL Server (MSSQLSERVER) and select Properties.

In the Properties dialog, from the Startup type list, select Automatic. Click OK.

Right-click SQL Server (MSSQLSERVER) and select Stop, then right-click it again and select
Start.

Close the Services and Administrative Tools windows.

Troubleshooting: "Failed to load DLL: MtCmnSec”
exception during AS300 server packages installation

(Topic number: 120619)

Issue

During the IMPAX 6.5.1 AS300 server packages installation, after typing your name and clicking
Next, an exception occurs and the message Failed to load DLL: MtCmnSec is displayed.

Details

This exception could indicate that a different version of the LIBEAY32.dll file in the
C:\windows\system32 directory is causing a version conflict.

Solution

1.

Before closing the exception message, in Windows Explorer, search for the location of the
MtCmnSec.dll that is used by the AS300 installer. The file is usually located in a directory under
C:\Documents and Settings\Administrator\Local Settings\Temp\{some_string}\Disk1. For
example:

C:\Documents and Settings\Administrator\Local
Settings\Temp\{61BCEOED-5E0C-4A36-9F55-C23DAAB20CID}\Diskl

. Open a command prompt and change directories to the folder found in the previous step.

3. Type

rundll32 mtcmnsec.dll,mtGetWindowsVersion
An error similar to the following may appear:

The ordinal 3823 could not be located in the dynamic link library
LIBEAY32.dlI
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This error indicates that a different version of the LIBEAY32.dll file in the C:\windows\system32
directory is causing a version conflict.

4. Rename the copy in C:\windows\system32 and run the AS300 installer again.

Troubleshooting: Server name registered in SQL
Server is incorrect

(Topic number: 7625)

Issue

If the server name registered in SQL Server is not the same as the server name registered in Windows,
you must update the server name in SQL Server.

Details
This discrepancy may happen if you use a ghost image when installing the third-party applications.

Solution

To check the server name registered in Windows
1. Right-click My Computer and select Properties.

2. Switch to the Computer Name tab.

The server name is listed as the full server name.

To check the server name registered in SQL Server
1. Ina SQL Server query window, type select @@servername

To update the server name registered in SQL Server
1. In the SQL Server query window, type:

sp_dropserver old_server_name

go
sp_addserver server_name_as_in_Windows, local
go
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Uninstalling
IMPAX 6.5.1

If you encounter installation problems or need to redeploy the workstation, you may have to uninstall
some of the IMPAX software.

Uninstalling the IMPAX Migration Tools from a
Windows computer

(Topic number: 47239)

Once all migration tasks and post-migration checks are completed, you must uninstall the IMPAX
Migration Tools from all Windows-based computers on which they are installed. This is a legal
requirement.

To uninstall the IMPAX Migration Tools from a Windows computer
1. Open Control Panel.

2. Select Add or Remove Programs.

3. Select IMPAX 6.5.1 AS300 Migration 6.5.0.xxx
where xxx is the build number.

4. Click Remove.

5. In the Confirm File Deletion dialog, click Yes.

6. At the Uninstall complete prompt, click Finish.
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Uninstalling IMPAX 6.5.1 Client

(Topic number: 7607)

The following procedure removes the IMPAX Client software, but not any integrated software (such
as the Orthopaedic Application, TalkStation, or Voxar).

To uninstall IMPAX 6.5.1 Client
If the IMPAX Client is running, log out of it and close the Login window.

Open the Control Panel.
Select Add or Remove Programs.
Under Currently installed programs, select IMPAX Client.

Click Remove.

AL o

When asked to confirm the removal, click Yes.

A Preparing to remove dialog opens, then the IMPAX Client software is uninstalled.

Uninstalling IMPAX 6.5.1 Business Services

(Topic number: 7608)

If you must back out of an installation, or reinstall the IMPAX Business Services, use the following
instructions.

To uninstall IMPAX 6.5.1 Business Services
1. Open Control Panel, select Add or Remove Programs.

2. Select Adam Instance AgfaHealthcare or AD LDS Instance AgfaHealthcare and click Remove.
3. Ensure that C:\Program Files\Agfa is empty.
4

. Ensure that the AgfaHC virtual directories are removed. These directories are located wherever
the web services were installed.

Uninstalling the IMPAX 6.5.1 documentation

(Topic number: 118482)

If required, you can uninstall the IMPAX 6.5.1 documentation.

To uninstall the IMPAX 6.5.1 documentation
1. Open Control Panel.
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2. Select Add or Remove Programs.

3. In the Add or Remove Programs dialog, under Currently installed programs, select AGFA
IMPAX version Knowledge Base buildnumber Documentation.

4. Click Remove.
5. In the confirmation dialog, click OK.

A progress dialog appears as the documentation is uninstalled, giving the amount of time
remaining. When the process is complete, the dialog closes.

6. Close the Add or Remove Programs dialog.

All installed IMPAX 6.5.1 documentation is uninstalled.

Uninstalling IMPAX 6.5.1 Server

(Topic number: 7605)

To uninstall IMPAX 6.5.1 Server
1. Open Control Panel.

2. Depending on the version of Windows, select Add or Remove Programs or Programs and
Features.

Under Currently installed programs, select AGFA IMPAX AS300.
Click Change.

At the prompt, type your name and click Next.

At the Welcome dialog, select Modify. Click Next.

Click Next.
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In the Maintenance Complete dialog, select Yes, I want to restart my computer now and click
Finish.

9. If no longer required on this server, you can also delete any Server license files stored in the
C:\mvf directory.
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External
software licenses

Some of the software provided utilizes or includes software components licensed by third parties,
who require disclosure of the following information about their copyright interests and/or licensing
terms.

Cygwin

(Topic number: 121758)

Copyright 1998, 1999, 2000, 2001, 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009, 2010 Red Hat,
Inc.

This program is free software; you can redistribute it and/or modify it under the terms of the GNU
General Public License (GPL) as published by the Free Software Foundation version 2 of the License.

This program is distributed in the hope that it will be useful, but WITHOUT ANY WARRANTY;
without even the implied warranty of MERCHANTABILITY or FITNESS FOR A PARTICULAR
PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this program; if not,
write to the Free Software Foundation, Inc., 59 Temple Place - Suite 330, Boston, MA 02111-1307,
USA.

GNU GENERAL PUBLIC LICENSE
Version 2, June 1991

Copyright (C) 1989, 1991 Free Software Foundation, Inc., 675 Mass Ave, Cambridge, MA 02139,
USA. Everyone is permitted to copy and distribute verbatim copies of this license document, but
changing it is not allowed.

Preamble
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The licenses for most software are designed to take away your freedom to share and change it. By
contrast, the GNU General Public License is intended to guarantee your freedom to share and change
free software--to make sure the software is free for all its users. This General Public License applies
to most of the Free Software Foundation's software and to any other program whose authors commit
to using it. (Some other Free Software Foundation software is covered by the GNU Library General
Public License instead.) You can apply it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses
are designed to make sure that you have the freedom to distribute copies of free software (and charge
for this service if you wish), that you receive source code or can get it if you want it, that you can
change the software or use pieces of it in new free programs; and that you know you can do these
things.

To protect your rights, we need to make restrictions that forbid anyone to deny you these rights or
to ask you to surrender the rights. These restrictions translate to certain responsibilities for you if
you distribute copies of the software, or if you modify it.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must give
the recipients all the rights that you have. You must make sure that they, too, receive or can get the
source code. And you must show them these terms so they know their rights.

We protect your rights with two steps: (1) copyright the software, and (2) offer you this license which
gives you legal permission to copy, distribute and/or modify the software.

Also, for each author's protection and ours, we want to make certain that everyone understands that
there is no warranty for this free software. If the software is modified by someone else and passed
on, we want its recipients to know that what they have is not the original, so that any problems
introduced by others will not reflect on the original authors' reputations.

Finally, any free program is threatened constantly by software patents. We wish to avoid the danger
that redistributors of a free program will individually obtain patent licenses, in effect making the
program proprietary. To prevent this, we have made it clear that any patent must be licensed for
everyone's free use or not licensed at all.

The precise terms and conditions for copying, distribution and modification follow.
GNU GENERAL PUBLIC LICENSE
TERMS AND CONDITIONS FOR COPYING, DISTRIBUTION AND MODIFICATION

1. This License applies to any program or other work which contains a notice placed by the
copyright holder saying it may be distributed under the terms of this General Public License.
The "Program”, below, refers to any such program or work, and a "work based on the Program"
means either the Program or any derivative work under copyright law: that is to say, a work
containing the Program or a portion of it, either verbatim or with modifications and/or
translated into another language. (Hereinafter, translation is included without limitation in
the term "modification".) Each licensee is addressed as "you".

Activities other than copying, distribution and modification are not covered by this License;
they are outside its scope. The act of running the Program is not restricted, and the output
from the Program is covered only if its contents constitute a work based on the Program
(independent of having been made by running the Program). Whether that is true depends
on what the Program does.
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2. You may copy and distribute verbatim copies of the Program's source code as you receive it,
in any medium, provided that you conspicuously and appropriately publish on each copy an
appropriate copyright notice and disclaimer of warranty; keep intact all the notices that refer
to this License and to the absence of any warranty; and give any other recipients of the Program
a copy of this License along with the Program.

You may charge a fee for the physical act of transferring a copy, and you may at your option
offer warranty protection in exchange for a fee.

3. You may modify your copy or copies of the Program or any portion of it, thus forming a work
based on the Program, and copy and distribute such modifications or work under the terms
of Section 1 above, provided that you also meet all of these conditions:

a. You must cause the modified files to carry prominent notices stating that you changed
the files and the date of any change.

b. You must cause any work that you distribute or publish, that in whole or in part contains
or is derived from the Program or any part thereof, to be licensed as a whole at no charge
to all third parties under the terms of this License.

c. If the modified program normally reads commands interactively when run, you must
cause it, when started running for such interactive use in the most ordinary way, to print
or display an announcement including an appropriate copyright notice and a notice that
there is no warranty (or else, saying that you provide a warranty) and that users may
redistribute the program under these conditions, and telling the user how to view a copy
of this License. (Exception: if the Program itself is interactive but does not normally print
such an announcement, your work based on the Program is not required to print an
announcement.)

These requirements apply to the modified work as a whole. If identifiable sections of that work
are not derived from the Program, and can be reasonably considered independent and separate
works in themselves, then this License, and its terms, do not apply to those sections when you
distribute them as separate works. But when you distribute the same sections as part of a whole
which is a work based on the Program, the distribution of the whole must be on the terms of
this License, whose permissions for other licensees extend to the entire whole, and thus to each
and every part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work written
entirely by you; rather, the intent is to exercise the right to control the distribution of derivative
or collective works based on the Program.

In addition, mere aggregation of another work not based on the Program with the Program
(or with a work based on the Program) on a volume of a storage or distribution medium does
not bring the other work under the scope of this License.

4. You may copy and distribute the Program (or a work based on it, under Section 2) in object
code or executable form under the terms of Sections 1 and 2 above provided that you also do
one of the following:

a. Accompany it with the complete corresponding machine-readable source code, which
must be distributed under the terms of Sections 1 and 2 above on a medium customarily
used for software interchange; or,
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b. Accompany it with a written offer, valid for at least three years, to give any third party,
for a charge no more than your cost of physically performing source distribution, a
complete machine-readable copy of the corresponding source code, to be distributed
under the terms of Sections 1 and 2 above on a medium customarily used for software
interchange; or,

¢. Accompany it with the information you received as to the offer to distribute corresponding
source code. (This alternative is allowed only for noncommercial distribution and only
if you received the program in object code or executable form with such an offer, in accord
with Subsection b above.)

The source code for a work means the preferred form of the work for making modifications
to it. For an executable work, complete source code means all the source code for all
modules it contains, plus any associated interface definition files, plus the scripts used to
control compilation and installation of the executable. However, as a special exception,
the source code distributed need not include anything that is normally distributed (in
either source or binary form) with the major components (compiler, kernel, and so on)
of the operating system on which the executable runs, unless that component itself
accompanies the executable.

If distribution of executable or object code is made by offering access to copy from a
designated place, then offering equivalent access to copy the source code from the same
place counts as distribution of the source code, even though third parties are not compelled
to copy the source along with the object code.

5. You may not copy, modify, sublicense, or distribute the Program except as expressly provided
under this License. Any attempt otherwise to copy, modify, sublicense or distribute the Program
is void, and will automatically terminate your rights under this License. However, parties who
have received copies, or rights, from you under this License will not have their licenses
terminated so long as such parties remain in full compliance.

6. You are not required to accept this License, since you have not signed it. However, nothing
else grants you permission to modify or distribute the Program or its derivative works. These
actions are prohibited by law if you do not accept this License. Therefore, by modifying or
distributing the Program (or any work based on the Program), you indicate your acceptance
of this License to do so, and all its terms and conditions for copying, distributing or modifying
the Program or works based on it.

7. Each time you redistribute the Program (or any work based on the Program), the recipient
automatically receives a license from the original licensor to copy, distribute or modify the
Program subject to these terms and conditions. You may not impose any further restrictions
on the recipients' exercise of the rights granted herein. You are not responsible for enforcing
compliance by third parties to this License.

8. If, as a consequence of a court judgment or allegation of patent infringement or for any other
reason (not limited to patent issues), conditions are imposed on you (whether by court order,
agreement or otherwise) that contradict the conditions of this License, they do not excuse you
from the conditions of this License. If you cannot distribute so as to satisfy simultaneously
your obligations under this License and any other pertinent obligations, then as a consequence
you may not distribute the Program at all. For example, if a patent license would not permit
royalty-free redistribution of the Program by all those who receive copies directly or indirectly
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through you, then the only way you could satisfy both it and this License would be to refrain
entirely from distribution of the Program.

If any portion of this section is held invalid or unenforceable under any particular circumstance,
the balance of the section is intended to apply and the section as a whole is intended to apply
in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other property
right claims or to contest validity of any such claims; this section has the sole purpose of
protecting the integrity of the free software distribution system, which is implemented by public
license practices. Many people have made generous contributions to the wide range of software
distributed through that system in reliance on consistent application of that system; it is up to
the author/donor to decide if he or she is willing to distribute software through any other
system and a licensee cannot impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence of the
rest of this License.

9. If the distribution and/or use of the Program is restricted in certain countries either by patents
or by copyrighted interfaces, the original copyright holder who places the Program under this
License may add an explicit geographical distribution limitation excluding those countries, so
that distribution is permitted only in or among countries not thus excluded. In such case, this
License incorporates the limitation as if written in the body of this License.

10. The Free Software Foundation may publish revised and/or new versions of the General Public
License from time to time. Such new versions will be similar in spirit to the present version,
but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies a version number
of this License which applies to it and "any later version", you have the option of following the
terms and conditions either of that version or of any later version published by the Free Software
Foundation. If the Program does not specify a version number of this License, you may choose
any version ever published by the Free Software Foundation.

11. If you wish to incorporate parts of the Program into other free programs whose distribution
conditions are different, write to the author to ask for permission. For software which is
copyrighted by the Free Software Foundation, write to the Free Software Foundation; we
sometimes make exceptions for this. Our decision will be guided by the two goals of preserving
the free status of all derivatives of our free software and of promoting the sharing and reuse of
software generally.

NO WARRANTY

1. BECAUSE THE PROGRAM IS LICENSED FREE OF CHARGE, THERE IS NO WARRANTY
FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT
WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR OTHER
PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS
WITH YOU. SHOULD THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE COST
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION
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2. INNO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING
WILLANY COPYRIGHT HOLDER, ORANY OTHER PARTY WHO MAY MODIFY AND/OR
REDISTRIBUTE THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR
DAMAGES, INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL
DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM
(INCLUDING BUT NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED
INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF
THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER
OR OTHER PARTY HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

END OF TERMS AND CONDITIONS

Editline 1.2-cstr

(Topic number: 121768)

Copyright 1992 Simmule Turner and Rich Salz. All rights reserved. This software is not subject to
any license of the American Telephone and Telegraph Company or of the Regents of the University
of California. Permission is granted to anyone to use this software for any purpose on any computer
system, and to alter it and redistribute it freely, subject to the following restrictions: 1. The authors
are not responsible for the consequences of use of this software, no matter how awful, even if they
arise from flaws in it. 2. The origin of this software must not be misrepresented, either by explicit
claim or by omission. Since few users ever read sources, credits must appear in the documentation.
3. Altered versions must be plainly marked as such, and must not be misrepresented as being the
original software. Since few users ever read sources, credits must appear in the documentation. 4.
This notice may not be removed or altered.

ICU License - ICU 1.8.1 and later

(Topic number: 13533)

COPYRIGHT AND PERMISSION NOTICE
Copyright © 1995-2003 International Business Machines Corporation and others. All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the “Software”), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of
the Software, and to permit persons to whom the Software is furnished to do so, provided that the
above copyright notice(s) and this permission notice appear in all copies of the Software and that
both the above copyright notice(s) and this permission notice appear in supporting documentation.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE AND NON INFRINGEMENT OF THIRD PARTY
RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FOR ANY CLAIM, ORANY SPECIAL INDIRECT OR CONSEQUENTIAL
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DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR
PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF
THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising
or otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective
owners.

OpenSSL

(Topic number: 121771)

This is a copy of the current LICENSE file inside the CVS repository.
LICENSE ISSUES

The OpenSSL toolkit stays under a dual license, i.e. both the conditions of the OpenSSL License and
the original SSLeay license apply to the toolkit. See below for the actual license texts. Actually both
licenses are BSD-style Open Source licenses. In case of any license issues related to OpenSSL please
contact openssl-core@openssl.org.

OpenSSL License
/>(-

* Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgment: "This product includes software developed by the OpenSSL Project for use
in the OpenSSL Toolkit. (http://www.openssl.org/)"

4. The names "OpenSSL Toolkit" and "OpenSSL Project” must not be used to endorse or promote
products derived from this software without prior written permission. For written permission,
please contact openssl-core@openssl.org.

5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear
in their names without prior written permission of the OpenSSL Project.
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6. Redistributions of any form whatsoever must retain the following acknowledgment: "This
product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit
(http://www.openssl.org/)"

*

* THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT “AS IS" AND ANY EXPRESSED
ORIMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THEIMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

*

*

* This product includes cryptographic software written by Eric Young (eay@cryptsoft.com). This
product includes software written by Tim Hudson (tjh@cryptsoft.com).

*
*/
Original SSLeay License

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.

* This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The
implementation was written so as to conform with Netscapes SSL.

*

*This library is free for commercial and non-commercial use as long as the following conditions are
aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA,
lhash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution
is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

* Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be
removed. If this package is used in a product, Eric Young should be given attribution as the author
of the parts of the library used. This can be in the form of a textual message at program startup or
in documentation (online or textual) provided with the package.

*

* Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:
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1. Redistributions of source code must retain the copyright notice, this list of conditions and the
following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

3. All advertising materials mentioning features or use of this software must display the following
acknowledgement: "This product includes cryptographic software written by Eric Young
(eay@cryptsoft.com)" The word 'cryptographic' can be left out if the rouines from the library
being used are not cryptographic related :-).

4. If you include any Windows specific code (or a derivative thereof) from the apps directory
(application code) you must include an acknowledgement: "This product includes software
written by Tim Hudson (tjh@cryptsoft.com)"

*

*THIS SOFTWARE IS PROVIDED BY ERIC YOUNG “AS IS" AND ANY EXPRESS OR IMPLIED
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.

* The licence and distribution terms for any publically available version or derivative of this code
cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence
[including the GNU Public Licence.]

*/

Xerces C++ Parser, version 1.2

(Topic number: 121761)

This product includes software developed by The Apache Software Foundation
(http://www.apache.org/). Please read the LICENSE files present in the Help > About dialog of the
IMPAX Client.
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Zlib

(Topic number: 7595)

zlib.h -- interface of the 'zlib' general purpose compression library Version 1.2.1, November 17th,
2003

Copyright (C) 1995-2003 Jean-loup Gailly and Mark Adler

This software is provided “as-is”, without any express or implied warranty. In no event will the
authors be held liable for any damages arising from the use of this software.
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Glossary

A
ADAM

Active Directory Application Mode. Directory
services for an individual application that
controls user login and privilege information.

Administration Tools

Administration Tools control the
configuration and management of the entire
IMPAX cluster. The Administration Tools are
a Java-based application that run in a web
browser.

C

CLUI

Command Line User Interface. A
command-line tool to help in the service of
IMPAX MVE. CLUT allows you to execute SQL
statements.

D
diagnostic monitor

High-quality, grayscale monitors in sizes
ranging from 1.3 to 5 MegaPixels, with either
a portrait or landscape orientation.

DICOM

Digital Imaging and Communications in
Medicine. The standard communication
protocol used by a PACS, HIS, or modality to
exchange information or images with other
systems.
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F
firewall

On alocal area network (LAN) connected to
a larger network, the security system that
prevents outside intrusion and that keeps
internal information from getting out.
Typically, all traffic must pass through the
machine on which the firewall is implemented.

H

hardware dongle

A device that attaches to a computer to control
access to a particular application. Dongles
provide the most effective means of copy
protection. Typically, the dongle attaches to a
PC’s USB port.

HTTP

Hypertext transfer protocol, a TCP-based
protocol for transferring hypertext requests
and information between servers and
browsers.

HTTPS

Hypertext transfer protocol, secure, a URL
access method for connecting to http servers
using SSL (secure sockets layer).

L
LDAP

Lightweight Directory Access Protocol, the
technology for storing user names and IDs,
passwords, and user-related preferences. This
information is stored in an LDAP depository.
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license, IMPAX Client

IMPAX Client licenses define which IMPAX
features users in a role can be given permission
to access. They include standard and optional
features. IMPAX Client license files are
installed on Application Servers and are
assigned to roles.

log file

A file or set of files containing a record of the
actions and modifications made in an
application. Service teams use log files during
setup and configuration of the system or its
components. Logs are also used to diagnose
problems. Logging can typically be set to
record varying levels of detail.

M
MAC address

Media Access Control address. The unique
physical address of each device’s network
interface card.

MIP

Maximum Intensity Projection. Refers to a
projection of the 3D object that shows the
tissues of highest density.

modality

An imaging discipline, such as CT, or a device
that gathers digital information, such as
digitizers for X-ray film, MRI scanners, and
CR devices.

MPR

Multi-Planar Reformatting. A method of
visualization in three-dimensional medical
imaging. This method allows you to view
anatomy along its central axis, or
perpendicularly to that central axis.
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0]

operations, IMPAX

The IMPAX actions allowed by a permission.
For example, operations include dictation,
printing to paper, and executing SQL
statements through CLUI. You can further
refine some operations by setting a study status
flag on the operation. For example, you can
allow printing only on dictated studies.

Orthopaedic Application

Application integrated with the IMPAX Client,
used to do pre-surgical and postoperative
planning for orthopaedics.

P

PACS
A Picture Archive and Communication
Systems (PACS) makes it possible to

electronically store, manage, distribute, and
view images.

permissions, IMPAX

Permissions define the available IMPAX
features and types of studies that users in a
particular role have access to. Permissions are
made up of a set of operations.

S
site

A type of resource, referring to the overall
hospital facility that houses departments,
locations, specialties, and stations.

SSL certificate

A digital certificate with the SSL protocol that
has been issued by a certificate authority.

stations

Within the context of the IMPAX Client
configuration interface, refers to a computer
that has the IMPAX Client installed. Stations
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can be in a radiology reading room, in the
offices of clinicians, or in the homes of
radiologists, for example. When a user logs
into IMPAX for the first time, the computer
name is listed in the navigation pane of the
Configure area - Stations section. Stations are
organized under station containers. You can
set configuration options, such as diagnostic
monitor settings, memory usage, and so on,
for a specific station, or the station can inherit
its configuration from the station container.

W

wizard

Wizards are used to automate processes.
Wizards perform a predetermined sequence
of actions after they are selected and applied.

workflow

A sequence of events, initiated by a trigger
event.

worklist

A collection of patients and their studies. For
radiologists, the worklist is analogous to a pile
of film jackets. They use the worklist to know
which studies they must interpret during a
specific time period. For technologists, a
worKklist is a list of the studies they must
perform at specific times for each patient.
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certificates
See SSL certificates

changing
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Clients
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